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FCC Notices

Class B Part 15 Information

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:
(1) this device may not cause harmful interference, and (2) this device must accept any interference received,
including interference that may cause undesired operation.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to
Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses, and can radiate radio frequency
energy and, if not installed and used in accordance with the instruction manual, may cause harmful
interference to radio communications. However, there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful interference to radio or television reception,
which can be determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

0 Reorient or relocate the receiving antenna.

o Increase the separation between the equipment and the receiver.

a  Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
a  Consult the dealer or an experienced radio/TV technician for help.

Changes or modifications to this equipment not expressly approved by the party responsible for compliance
could void the user’s authority to operate the equipment.

Switched-56 Connection Information

This equipment complies with Part 68 of the FCC Rules. An internal cover on the Switched-56-1 network
interface board has a label that contains, among other information, the FCC Registration Number and Ringer
Equivalence Number (REN) for this equipment. Upon request you must provide this information to your
telephone company.

The REN is useful to determine the quantity of devices you may connect to your telephone line and still have
all of those devices ring when your telephone number is called. In most but not all areas, the sum of the RENs
of all devices connected to one line should not exceed five (5.0). To be certain of the number of devices you
may connect to your line, as determined by the REN, you should contact your local telephone company to
determine the maximum REN for your calling area.

If your telephone equipment causes harm to the telephone network, the telephone company may discontinue
your service temporarily. If possible, they will notify you in advance. But if advance notice isn’t practical, you
will be notified as soon as possible. You will be informed of your right to file a complaint with the FCC.



Your telephone company may make changes in its facilities, equipment, operations, or procedures that could
affect the proper functioning of your equipment. If they do, you will be notified in advance to give you an
opportunity to maintain uninterrupted telephone service.

If you need more information on this subject please call 1-800-874-2835. The telephone company may ask
that you disconnect this equipment from the network until the problem has been corrected or until you are
sure that the equipment is not malfunctioning.

Installation
This device is equipped with a USOC RJ11C connector.

Warning: Changes or modifications to this unit not expressly approved by the party responsible for
compliance could void the user’s authority to operate the equipment.

Notice to Canadian Users

This digital apparatus does not exceed the Class B limits for radio noise emissions from digital apparatus set
out in the Radio Interference Regulations of the Canadian Department of Communications.

Le present appareil numberique n’emet pas de bruits radioelectriques depassant les limites applicables aux
appareils numberiques de la classe B prescrites dens le Reglement sur le brouillage radioelectrique edicte
par le ministere des Communications du Canada.

Notice: The Canadian Department of Communcations label identifies certified equipment. This certification
means that the equipment meets certain telecommunications network protective, operational, and safety
requirements. The Department does not guarantee the equipment will operate to the user’s satisfaction.

Before installing this equipment, users should ensure that it is permissible to be connected to the facilities of
the local telecommunications company. The equipment must also be installed using an acceptable method
of connection. In some cases, the company’s inside wiring associated with a single line individual service
may be extended by means of a certified connector assembly (telephone extension cord). The customer
should be aware that compliances with the above conditions may not prevent degradation of service in some
situations.

Repairs to certified equipment should be made by an authorized Canadian maintenance facility designated
by the supplier. Any repairs or alterations made by the user to this equipment, or equipment malfunctions,
may give the telecommunications company cause to request the user to disconnect the equipment.

Users should ensure, for their own protection, that the electrical ground connections of the power utility,
telephone lines, and internal metallic water pipe system, if present, are connected together. This precaution
may be particularly important in rural areas.



Caution: Users should not attempt to make such connections themselves, but should contact the
appropriate electric inspection authority, or electirician, as appropriate.

Bescheinigung des Herstellers/Importeurs

Hiermit wird bescheinigt, dass PictureTel LIVE PCS 50 in Ubereinstimmung mit den Bestimmungen der
BMPT-AmtsblVfg 243/1991 funkentstort ist. Der vorschriftsmassige Betrieb mancher Geréte (z.B.
Messsender) kann allerdings gewissen Einschrankungen unterliegen. Beachten Sie deshalb die HinWeise
in der Bedienungsanleitung.

Dem Zentralamt fuer Zulassungen im Femmeldewesen wurde das Inverkehrbringen dieses Geréates
angezeigt und die Berechtigung zur Uberprifung der Serie auf die Einhaltung der Bestimmungen
eingerdumt.

PictureTel GmbH, Biropark Oktavian, Miinchner Strasse 14, D-8043 Miinchen-Unterféhring, Germany



International Approvals

Live50

The PictureTel Live50 complies with EEC Directives 89/336EEC, 91/263/EEC, 93/68/EEC and European
Standards EN 55022B, EN50082-1, I-CTR3 and EN60950. The PictureTel Live50 includes a Euro-ISDN
Basic Access Port. The Euro-ISDN Basic Access Port has been approved for connection to the Public

Telecommunications Network by the British Approvals Board for Telecommunications (BABT).
Consequently, BABT has granted PictureTel the following Approval Marking:

ce168 X

The PictureTel Live50 ISDN Basic Access Port has been approved in France by DGPT. The following
Approval number has been assigned to the Chipshot ISDN port:

950508B.

The PictureTel Live50 ISDN Basic Access Port has been approved in Germany by BZT. The following
Approval number (Zulassungsnummer) has been assigned to the Chipshot ISDN Port:

BZ T A116384E
The PictureTel Live50 (PCS50 Chipshot) has been approved in Hong Kong by Hong Kong Telecom and has
been granted Permission to Connect (PTC) to Dataline BRI service. The following PTC Approval number has
been assigned:

PTC 205/94/SDWL

The PictureTel Live50 (PCS50 Chipshot) ISDN Port has been approved in Japan by JATE. The following
Approval number has been assigned to the CHIPSHOT ISDN Port:

T95-5037-2

The PictureTel Live50 (PCS50 Chipshot ) has been approved in Singapore by TAS and has been assigned
the following Approval number:

TAC No : ISDN1-ISTE-AC-0150-95

The PictureTel Live50 ISDN Basic Access Port has been approved in Switzerland by BAKOM. The following
Approval number has been assigned to the CHIPSHOT ISDN Port:

95.00.96.1.N



Live100

The PictureTel Live100 complies with EEC Directives 89/336EEC, 91/263/EEC, 93/68/EEC and European
Standards EN 55022B, EN50082-1, I-CTR3 and EN60950. The PictureTel Live100 includes a Euro-ISDN
Basic Access Port. The Euro-ISDN Basic Access Port has been approved for connection to the Public

Telecommunications Network by the British Approvals Board for Telecommunications (BABT).
Consequently, BABT has granted PictureTel the following Approval Marking:

ce168 X

The PictureTel Live100 (ESCAB) ISDN Basic Access Port has been approved in Australia by AUSTEL. The
following Approval number has been assigned to the ESCAB ISDN:

A94/38B/0389.

The PictureTel Live100 (ESCAB) ISDN Basic Access Port has been approved in France by DGPT. The
following Approval number has been assigned to the ESCAB ISDN:

94149B.

The PictureTel Live100 (ESCAB) ISDN Basic Access Port has been approved in Germany by BZT. The
following Approval number (Zulassungsnummer) has been assigned to the ESCAB ISDN:

A108535E

The PictureTel Live100 (ESCAB) ISDN Basic Access Port has been approved in New Zealand by Telecom
New Zealand. The following Telepermit number has been assigned to the ESCAB ISDN:

PTC 23/94/021

The PictureTel Live100 (ESCAB) ISDN Basic Access Module has been approved in Switzerland by BAKOM.
The following Approval number has been assigned to the ESCAB ISDN:

94.06.11.1.N



Notice to Users of Public DATAPHONE® Digital Service
The following instructions are provided to ensure that you comply with FCC Rules, Part 68.

1.

All direct connections to DDS lines must be made through standard plugs and jacks furnished by the
telephone company. No connections can be made to party lines or coin lines. Before connecting your
unit, you must do the following:

a. Tell your local telephone company that you have an FCC registered device and that you wish to
connect to the company’s line. Provide them with the 14-digit FCC registration number listed on the
device’s label. They will also need to know the facility interface code and service code to connect
the necessary service. For your unit, the facility interface code is 04DU5-56 for 56 kbps service.
The service code is 6.0Y.

b. Inform the local telephone company of the jack arrangement you want to use, which is RJ-48S.

c. Connect the channel service unit (CSU) with the appropriate cable after the telephone company
has installed the requested jack.

If the unit appears to be malfunctioning, it should be disconnected from the telephone line until you learn
if your equipment or the telephone line is the source of the trouble. If your equipment needs repair, it
should not be reconnected until it is repaired.

The CSU is designed to prevent harm to the DDS network. If the telephone company finds that the
equipment exceeds tolerance parameters, the telephone company can temporarily disconnect service,
although they will attempt to give you advance notice if possible.

Under FCC Rules, no customer is authorized to repair this equipment. This restriction applies
regardless of whether the equipment is in or out of warranty.

If the telephone company alters their equipment or operations in a manner that will affect use of this
device, they must give you advance warning so as to give you the opportunity for uninterrupted service.
You will be advised of your right to file a complaint with the FCC.

In the event of equipment malfunction, all repairs should be performed by PictureTel Corporation or an
authorized agent. It is the responsibility of the users requiring service to report the need for service to
our company or to one of our authorized agents.
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Upgrading

Windows 3.1 vs
Windows 95

About This Guide

This guide tells you how to install the PictureTel Live50 and Live100
(formerly PCS 50™ and PCS 100™) desktop videoconferencing
systems on your personal computer.

This guide covers both hardware and software installation. It
assumes that you're familiar with installing PC add-on boards,
installing and using Microsoft® Windows™ applications, and
connecting PCs to peripheral equipment.

Anyone performing the procedures in this guide should have prior
experience installing computer equipment.

If you are upgrading your PictureTel Live software from a previous
version, you can turn directly to Chapter 4, Installing PictureTel Live
Software. The procedure for installing the upgrade is the same as for
installing the original software.

For support or service, please contact your PictureTel service
provider or call Customer Service at 508-292-5999. If you are located
in the United States, you may call 800-874-2835 during your local
business hours.

PictureTel Live, version 1.6, is a Windows 3.1x application that can
be installed and used in a Windows 95 operating environment.

Window and dialog displays in this manual are based on the
Windows 3.1x graphical user interface. If you are a Windows 95
user, the graphical interface and the associated window controls for
expanding, contracting, and scrolling will be different than what is
presented in this manual.

XV
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Getting Started

Overview The PictureTel Live50 and Livel00 are PC desktop
videoconferencing products that give you full-color, full-motion,
live video and audio with information-sharing capabilities.

For a complete description about using these products, see the
PictureTel Live User’s Guide.

In this Chapter

This chapter covers the following major topics:

Topic Page
System Requirements 2
Live50 Package Contents 2
Livel00 Package Contents 4
Before Installing PictureTel Live 7
Your Installation 9
For Specific Information 10

1-1



GETTING STARTED

System
Requirements

Live50 Package
Contents

1-2

To install and operate PictureTel Live50 or Livel00, your PC must
meet the following requirements:

Q

o 0o o o o

80386 (or better) CPU

8MB of memory, with at least 20MB of virtual memory
20MB of available hard disk space

Microsoft Windows 3.1x or Windows 95

VGA or SVGA monitor

For the Live50 - ISA (AT) or EISA bus with two expansion slots
(one slot must accommodate a full-length PC board).

For the Live100 - ISA (AT) or EISA bus with two full-length
expansion slots available.

If the slots are not adjacent to each other, use the eight-inch
PictureTel cable #510-0210-01 to connect the two PictureTel Live
boards. Refer to Appendix K for information about ordering
components from PictureTel.

The PictureTel Live50 package includes the following:

u]

[ A A

Live50 board

VGA board with a VESA (Video Electronics Standards
Association) Advanced Feature Connector

Live 50 Desktop video camera or optional FlipCam camera.
Earpiece or optional Speakerphone unit with handset
Cables

PictureTel Live and LiveShare Plus Software



Live50 Package Contents

The Live50 Video Cameras

The Live50 product is equipped with one of two different camera
types, a desktop video camera, or a FlipCam camera.

—
@\%M

The basic Live50 camera is a color video camera for the desktop
environment that can be placed on top of your PC monitor for
capturing your image during a videoconferencing session. It has a
fixed focus and a tilt base for positioning.

Live50
Desktop Camera

Sliding shutter

Lens

is)

Live50
FlipCam Camera

The FlipCam video camera is also a color video camera for your
desktop that can be adjusted to a wide range of subjects and lighting
conditions and provides manual zoom, focus, and brightness (iris)
controls, as well as a privacy shutter that you can use when you
don’t want to be on camera.



GETTING STARTED

Live100 Package The PictureTel Live100 package includes the following items:
Contents 2 VGA Video board
0 Audio Communications board with ISDN BRI network inteface
a FlipCam video camera (an optional FlipCam stand is available)
0 Speakerphone unit with handset
o Cables

a PictureTel Live and LiveShare Plus Software

The Live100 FlipCam Camera

The FlipCam is a color video camera for the desktop environment
that can be placed on top of your PC monitor for capturing your
image during a videoconferencing session.

Sliding shutter

Lens

Focus

Live100
FlipCam Camera

The FlipCam can be adjusted to a wide range of subjects and
lighting conditions and provides manual zoom, focus, and
brightness (iris) controls, as well as a privacy shutter that you can
use when you don’t want to be on camera.



Live100 Package Contents

Speakerphone Unit

The speakerphone is a free-standing unit that includes a handset,
microphone, and speaker. The color of the Livel00 speakerphone is
black, the color of the optional Live50 speakerphone is white.

Mute button
Headset button
Speaker button

Microphone

Handset
Volume up button
Volume down button

Speaker

You can also plug in an optional headset for more private
conversations. The buttons on the front of the unit let you control the
volume, mute the audio, and select the speaker or optional headset.

1-5



GETTING STARTED

PictureTel Live PictureTel Live software for release 1.6 is distributed on the
Software following disks:
ET——EH Live50 or Live100
! Version 1.6
[ ]
—|Ver 1.6

i Liveshare Plus
| Vveshare Plus  and L Version 3.0

; for Windows 95
| Ver 2.2 for Windows 3.1x Ver 3.0

L] PictureTel VGA Drivers
VGA (for Live100 applications only)

Note: VGA drivers for Live50 are supplied with the VGA
card shipped with the Live50 product.

The PictureTel Live software includes:

o The PictureTel Live application that lets you conduct
videoconferences from your Windows desktop. The PictureTel
Live application is delivered on 3.5” diskettes and can be
installed on either Windows 3.1x or Windows 95 operating
systems

o The PictureTel LiveShare Plus (LSP) software that lets you
share online information with videoconferencing participants.
The LSP application is delivered in two different versions:

¢ One version (3.5” diskettes) for installation in a Windows
3.1x operating system

¢ One version (3.5”diskettes) for installation in a Windows 95
operating system
You only need to install one set of LSP diskettes. If you are
currently working in a Windows 3.1x environment, you need to
install the LSP 2.2 diskettes. If you are working in a Windows 95
environment, you need to install the LSP 3.0 diskettes.

o The PictureTel Live VGA drivers with accelerated graphics that
let you display both graphics and live, full-motion video on
your PC monitor. The drivers are contained on a separate 3.5 “

1-6



Before Installing PictureTel Live

Before Installing
PictureTel Live

diskette and distributed with Live100 applications only. Live50
applications use the VGA drivers that come with the supplied
video board.

0 The software release notes (the README.TXT file)

Installing the PictureTel Live system is a multiple step process that
includes hardware and software installation.

The following paragraphs describe considerations and decisions
you need to make before installing the PictureTel Live product.

Consider Your Networking Environment

You need to determine what type of network connection you need
to establish your videoconferencing connections.

Does your facility use direct ISDN connections?
Does your facility use Switched-56 connections?

Consult with your systems administrator or your Information
Systems department to determine the type of connection you need
for your PC connection to allow you to videoconference.

If you are setting up videoconferencing for the first time, you need
to contact your telephone company for ISDN service. Refer to the
Appendix E, How to Order ISDN Services , in the back of this manual.

Installing PictureTel Live for the First Time

Installing PictureTel Live50 or Livel(0 for the first time involves
installing hardware and software. The installation consists of the
following steps:

1. Installing the VGA Video drivers and Video board.

2. Installing the Live50 Board or the Live100 Audio Communications
board.

3. Connecting the boards together.
4. Attaching labels to the backplates of the new boards.

5. Installing the correct LiveShare Plus software for Windows 3.1 or
Windows 95.

1-7



GETTING STARTED

6. Installing the PictureTel Live50 or Live100 software.

7. Testing the system.

If you are installing an optional Network Interface board

If you are installing an optional network interface board that allows
you to make the appropriate connections to your videoconferencing
network, refer to Appendix C for specific installation instructions.

Installing Over a Previous Version

If you are installing the 1.6 version of Live over an existing version
of a PictureTel PCS Live product, you need to know the following
information to complete the new installation:

o IRQ setting and I/O port address of PCS 50 or PCS 100 Audio
Communications board [PICTEL00]

o IRQ setting and I/O port address of any Network Interface
boards [PICTELO02, 03, ...]

0 Your Service Provider Identification (SPID) numbers

0 Your Multiple Subscriber Numbers (MSN), for switches outside
the USA and Canada that allow multiple terminals on a single
line

Run your current PictureTel Live Configure program to obtain this
information.

We also recommend that you backup your phone book (consisting
of both .pbk and .mdx files in the PCS directory) to preserve the
addresses you want to maintain from your previous version of Live.

About the 384 Kbps Option

1-8

If you are currently using the enhanced 384 Kbps option for
increasing the bandwidth beyond 128Kbps, no action is required
since this option remains in effect after upgrading to version 1.6.

If you are adding the 384 Kbps option that allows you to place a call
using a bandwidth speed beyond the normal 128 Kbps, there is an
extra installation step required to load the 384 software. The 384
Kbps option allows you to select a bandwidth speed between 128
and 384 Kbps.



Your Installation

Your Installation The number of steps in your installation process is going to vary for
any of the following reasons:

0 You are using Windows 3.1x or upgrading to Windows 95

0 You are installing PictureTel Live for the first time or you are
upgrading from a previous version of PictureTel Live

0 Your network connection type is ISDN, or SW-56, V.35 or RS-
449

0 You are adding the 384 Kbps software option

The information below presents a very brief description of your
customized PictureTel Live installation.

If you are installing PictureTel Live Your installation steps are:

and you are...
A new PictureTel Live customer using 1. VGA Video Drivers and Board
Windows 3.1x 2. Live50 or Live100 Audio
Communications Board
3. LiveShare Plus 2.2
4. Live 1.6
A new PictureTel Live customer using 1. VGA Video Drivers and Board
Windows 95 2. Live50 or Live100 Audio
Communications Board
3. LiveShare Plus 3.0
4. Live 1.6
A current PictureTel Live user 1. LiveShare Plus 2.2

upgrading from a previous version of 2. Live 1.6
Live to release 1.6 running under
Windows 3.1x

A current PictureTel Live user 1. Windows 95
upgrading from Windows 3.1x to 2. Reinstall VGA Drivers
Windows 95, and upgrading from a 3. LiveShare Plus 3.0

4. Live 1.6

previous version of Live to 1.6




GETTING STARTED

For Specific

Information
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If you are installing PictureTel Live
and you are...

Your installation steps are:

A new PictureTel Live customer using
Windows 3.1x and installing the 384
option

. VGA Video Drivers and Board
. Live50 or Live100 Audio

Communications Board

. LiveShare Plus 2.2
. Live 1.6
. 384 software

A new PictureTel Live customer using
Windows 95 and installing the 384
option

. VGA Video Drivers and Board
. Live50 or Live100 Audio

Communications Board

. LiveShare Plus 3.0
. Live 1.6
. 384 software

Please refer to the following table for more specific information

about installing PictureTel Live:

For information about... Refer to...
Installing PictureTel Live50 Hardware Chapter 2
Installing PictureTel Livel00 Hardware Chapter 3
Installing PictureTel Live Software Chapter 4
Troubleshooting Chapter 5
Checking Your PC Settings Appendix A
Changing Settings On Live100 Boards Appendix B
Installing Network Interface Boards Appendix C
Installing the 384 Kbps Option Appendix D
How to Order ISDN Services in the United Appendix E
States




For Specific Information

For information about... Refer to...
Deinstalling PictureTel Live Appendix F
Changing The Video Mode Setting Appendix G
Installation Requirements Outside of the Appendix H
United States

Performance Tips Appendix I
Laptop Docking Station Configuration Appendix |
Ordering And Returning Components Appendix K
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Installing
Picturelel Live50
Hardware

Overview This chapter tells you how to install the PictureTel Live50 hardware.
If you are not familiar with installing PC boards and peripherals,
you should have an experienced person install the hardware for
you.

Note: If you are installing the Livel00 product, refer to
Chapter 3, Installing PictureTel Livel00 Hardware

In this Chapter

This chapter covers the following required ([_])and optional ([])
hardware installation steps:

Step Topic Page
1 Checking Your PC Settings 3
2 Opening Your PC 4
3 Replacing Your VGA Board 4
4 Installing the Live50 Board 5
5 Installing Optional Network Interface 8
Boards
6 Labeling the Live50 Board 9
7 Closing Your PC 9
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INSTALLING PICTURETEL LIVE50 HARDWARE

Step Topic Page
8 Connecting the Cameras 10
9 Connecting the Earpiece 16
10 Connecting the Speakerphone Unit 17
11 Connecting Optional Equipment to the 19
Speakerphone
12 Connecting Other Audio Devices 20
13 Connecting to the Network 21
14 Restarting Your PC 21




Checking Your PC Settings

Checki ng Your Before installing the Live50 hardware, you must confirm which IRQ,
PC Settings I/0 port address, and shared memory settings are available for the
Live50 board to use.

1. Begin by checking your PC documentation, then check the
manufacturer’s documentation for settings used by any devices
you have added to your PC, such as:

o SCSI devices
o LAN cards
o Modems

Q Scanners

o Sound cards

2. As you check the manufacturer’s default settings, check to see if
you changed any of their default settings.

3. If your PC has an ISA bus, you can then run the Microsoft
Diagnostics program, as described in Appendix A, to check your
PC settings.

Note: Keep in mind that the Microsoft Diagnostics
program may not always report every setting that is
in use. The most accurate way to determine the
settings that are in use, is to check the
manufacturer’s documentation.

4. Write down the settings that are already in use.
5. Compare your list of settings that are in use with the default
settings for the Live50.
The default PC settings for the Live50 are:
e JRQ11
e [/O port address = 0280
® Shared memory space DO0O0-D3FF

If you are installing optional network interface boards, refer to
Appendix C, Installing Network Interface Boards for additional
IRQ and I/0 port address default settings.

6. If there is a conflict, change the settings in your Live50, as
described in Appendix B.
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Opening Your PC To open your PC and prepare it for the Live50 board, follow these
steps:
1. Power off your PC.

Leave your PC connected to the power source to provide a
ground connection.

Caution

Do not connect or disconnect hardware components when
your PC is on. Doing so may damage the hardware.

2. Disconnect your monitor cable, and other cables if necessary,
from the PC chassis.

3. Remove the chassis cover.

Refer to your PC documentation for instructions.

Replacing Your The first step of the PictureTel Live50 hardware installation is to
VGA Board replace your current VGA board with the VGA board shipped with
the Live50:

1. Remove your current VGA board (or follow the instructions in your
PC documentation for disabling the VGA from the motherboard).
2. Insert the VGA board shipped with your Live50 system.

For detailed instructions, see the documentation shipped with
the VGA board.

Note: The VGA drivers for your VGA board need to be
installed after you have finished with the Live50
hardware installation. Refer to Chapter 4, Installing
PictureTel Live Software for installation instructions.

When you're done, keep your PC chassis cover off, because
you’ll be installing the Live50 board next.
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Installing the Live50 Board

|nsta||ing the This section tells you how to install the Live50 board.

Live50 Board Note: For BABT (British Approvals Board for
Telecommunications - United Kingdom) and AUSTEL
(Australia) requirements for installing the Live50 board,
refer to Appendix H.

Inserting the Live50 Board
To insert the Live50 board:

1. Power off your PC.

For instructions, see your PC documentation.

Caution

ﬁ Do not connect or disconnect Live50 components when

your PC is on. Doing so may damage the Live50 hardware.

2. Locate an available ISA or EISA expansion slot next to the VGA
board, or locate the next available slot.

3. Remove the back plate of the expansion slot and save the screw.

4. Remove the Live50 board from its plastic antistatic package.

Caution

The Live50 board can be damaged by static discharge.
To equalize static charge, ground yourself by touching the

metal back panel of your PC.
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INSTALLING PICTURETEL LIVE50 HARDWARE

5. Check Switch 1 on the board to make sure it is set as shown below.

The first switch should be down (off), and the next three should
be up (on). This switch sets the I/O address.

Switch 1

e

[ iy e .

b

6. Insert the board into the expansion slot next to the VGA board, or
into the next available slot.

Make sure the board is securely seated in its slot.

7. Secure the board by replacing the screw that holds the back plate.



Installing the Live50 Board

Connecting the Live50 Board to the VGA Board
To connect the Live50 board to the VGA board:

1. Connect one end of the VAFC cable to the VESA Advanced Feature
Connector on the top of the Live50 board.

2. Connect the other end of the VAFC cable to the VESA Advanced
Feature Connector on the VGA board.

The VESA Advanced Feature Connector on your VGA board
might be different from the connector shown in the following
illustration. With some VGA boards, you might have to twist the
VAFC cable to connect it.

VAFC cable
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INSTALLING PICTURETEL LIVE50 HARDWARE

Installing
Optional Network
Interface Boards

If you are not using an ISDN connection, you have several network
connection options that require installing one or more network
interface boards. The following table identifies the appropriate
network interface board for each type of network connection. Refer
to Appendix C, Installing Network Interface Boards for a complete
description of the installation process.

If you need this
connection type:

The required hardware boards are
listed here:

ISDN (BRI)

No optional network interface boards are
required.

(Consult your telephone provider to
determine if a network termination device
(NT1) is required.)

Integrated 4-Wire SW56

Switched-56 Network Interface

V.35 (or RS-449) dialed/
nondialed

DDM /Network Interface

Note: For V.35 and RS-449 connections, CSU/DSUs (Channel
Service Unit/Data Service Units) may be required
between the PC and the telephone company’s digital
network connection. Your installation may already have
these devices in place. Consult your telephone company

representative.




Labeling the Live50 Board

Labe“ng the To attach the Live50 board label to your PC:
Live50 Board 1. Peel off the label.

2. Attach the label to your PC chassis to the left of the Live50 board,
with the triangles pointing toward the board.

\\:\\
I ! Q\\
i ‘ \\
' \ ISDN
Speakerphone
' @ Speaker
\ @ Microphone
§ ) : @ Camera
\
\

4

C|osing Your PC After you install and connect the Live50 board and attach the label,
replace the chassis cover on your PC. If you have disconnected any

cables, reconnect them.
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Con necting the This section tells you how to connect and mount both the Live50
Cameras desktop camera and the FlipCam camera.
Caution
Do not connect or disconnect Live50 components when
your PC is on. Doing so may damage the Live50 hardware.

Connecting the Live50 Desktop Camera

Camera connections are located in the rear of the unit. To connect the
camera:

1. Plug one end of the video cable into the socket labeled V'>=. on
the camera.

2. Plug the other end of the video cable into the socket labeled [} on
the Live50 board.

3. Plug the AC power adapter cable into the socket labeled 6V — on
the camera.
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Connecting the Cameras

4. Do one of the following:

o If youhave a camera with an AC power adapter like the one
labeled (A) in the illustration, plug the AC power adapter
into a power outlet.

o Ifyouhave a camera with an AC power adapter like the one
labeled (B), plug the AC power adapter into the extension
cable supplied by your distributor, and then plug the
extension cable into a power outlet.

&

®
®| Live50 board
®| socket labeled CH

)

-

a =

AC power adapter

Camera

&

®
®| Live50 board
®| socket labeled X

J
a««

Extension cable AC power adapter
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INSTALLING PICTURETEL LIVE50 HARDWARE

Mounting the Live50 Desktop Camera

You can mount the camera either on top of your PC monitor as
shown below, or on an overhead shelf.

2-12



Connecting the Cameras

Connecting the Live50 FlipCam Camera

To connect the FlipCam camera to the Live50 board, follow these
steps:

1. Tilt the camera body up and away from its circular base, as shown
in the illustration below.

To Live50 Camera Socket Lk

To Live50

/
FlipCam Speakerphone
Cable
Socket
‘ AV sesel @)
M\
Ferrite \\ \
Bead \ \( \
f \@ \

@ > \

\ \
\ \ \
\ N \
AN

\ \

Speakerphone N Live50 FlipCam

Cable Adapter Cable
P/N 510-0244-01

2. Locate the 8-pin FlipCam cable, with plugs labeled 8A).
The cable has a ferrite bead ( @ ) near one end.
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2-14

Caution

The cables for the speakerphone unit and the FlipCam are
similar, but they are not interchangeable. The end plugs on
the FlipCam cable are labeled and the plugs on the
Speakerphone cable are labeled (7). If you connect the
wrong cable, you might damage the Live50 components.

Be careful when you connect or disconnect the cable. When
connecting the cable, be sure the flat side of the plug lines
up with the flat side of the socket, as shown by the socket
label. When disconnecting the cable, be sure to release the
collar lock by pulling on the plug’s collar, not on the cable.

. Plug the end of the cable without the ferrite bead into the socket at

the back of the camera near the hinge.

Both the plug and the socket are labeled (8A). Push the plug
securely into the socket.

. Press the cable into the guide on the camera base.

. Connect the Live50 FlipCam Adapter cable to the FlipCam cable.

Both plugs are labled A

. Be sure your PC is turned off.

. Plug the yellow connector at end of the FlipCam Adapter cable into

the camera socket labeled LXon the Live50 board.

. Plug the male end of the parallel section of cable on the FlipCam

Adapter into the female socket labeled (7) on the Live50 board .
Both the plug and the socket are labeled (7).

The other end of this portion of cable is left open for connecting
the Speakerphone cable. The plugs on this cable and the
Speakerphone cable are both labeled (7).

If you are using the earpiece instead of the Speakerphone, this
section of cable must still be connected to the Live50 board to
supply power to the FlipCam.



Connecting the Cameras

Mounting and Positioning the FlipCam

The FlipCam camera is designed with flexibility in mind. You can
mount it in several ways, and you can quickly switch from one
mounting option to another.

Camera Mounting Options
You have two options for mounting the camera:
0 You can set the camera on any flat, surface.

If you're using this camera as your main camera, place it on top
of your video monitor. For other uses, you can place it on a shelf
or tabletop.

The camera base has a rubber surface to keep it from slipping.
0 You can mount the camera on a standard camera tripod.

The camera base has a standard-size threaded hole for tripod
mounting. You attach it to the tripod as you would any other
camera.
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INSTALLING PICTURETEL LIVE50 HARDWARE

Con necting the The PictureTel Live50 includes either an earpiece or an optional
Earpiece speakerphone unit as its audio device.
Caution
Do not connect or disconnect Live50 components when
your PC is on. Doing so may damage the Live50 hardware.

To connect the earpiece to the Live50 board:

1. Plug the black connector with the speaker icon :q into the socket
labeled | on the Live50 board.

2. Plug the red connector with the microphone icon § into the socket
labeled O on the Live50 board.

>

®

o @® |Speaker socket
] | © |Microphone socket
| ©

>
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Connecting the Speakerphone Unit

Con necting the The PictureTel Live50 includes either an earpiece or an optional
Speakerphone speakerphone unit as its audio device.
i To connect the speakerphone unit:
nit peakerp
Caution
Do not connect or disconnect Live50 components when
your PC is on. Doing so may damage the Live50 hardware.

Plug one end of the speakerphone cable into the socket labeled
(7) on the Live50 board as shown below, aligning the plug
carefully.

Socket labeled (7)

Socket labeled @

Socket labeled ¢~

Note: If you are using the optional FlipCam camera, you
connect the plug labeled (7) into the FlipCam
Adapter cable plug that is also labeled (7). Refer to
the FlipCam Adapter illustration on page 2-13.
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INSTALLING PICTURETEL LIVE50 HARDWARE

Caution

Be careful when you connect or disconnect the cable. When
connecting it, be sure the flat side of the plug lines up with
the flat side of the socket, as shown by the socket label.
When disconnecting it, first release the collar lock by sliding
the cable collar back toward you; then gently remove the
cable from its socket.

3. Plug the other end of the speakerphone cable into the socket
labeled (7) on the speakerphone unit, aligning the plug carefully.

4. Plug one end of the handset cable into the socket labeled f on
the speakerphone unit.

5. Plug the other end of the handset cable into the handset.
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Connecting Optional Equipment to the Speakerphone

Connecting
Optional
Equipment to the
Speakerphone

You can connect two optional pieces of equipment (available
through your PictureTel distributor) to the speakerphone unit:

0 A headset, to allow free use of your hands during a
videoconference while retaining privacy

o A power supply, for extra volume from the speakerphone

Power PC Optional  Headset
Connector Headset
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Connecting
Other Audio
Devices

2-20

In place of the earpiece or speakerphone, you can connect other
audio input and output devices to the Live50 board, such as a
multimedia microphone and amplified speakers. You plug the
microphone and speakers into the same sockets you use to connect
the earpiece.

To connect a multimedia microphone and amplified speakers:

1. Plug the stereo connector from the amplified speakers into the
socket labeled (| on the Live50 board.

‘ Warning

When you connect amplified speakers, use only a stereo
connector that has tip, ring, and sleeve segments, as shown
below. If you use a mono connector that has only tip and
sleeve segments, you might damage the Live50 board.

2. Plug the connector from the microphone into the socket labeled $
on the Live50 board.

Sleeve

Tip

Speaker e 17

Microphone

® oo @ KN




Connecting to the Network

Connecting to
the Network

The Live50 connection to the network is made from a socket in the
network interface board to a network service jack. To connect your
PC to the network, follow the procedure below for the network
interface board you have installed.

From the Live50 Board

To connect to an ISDN BRI network:

1. Plug one end of the 8-pin modular network cable into the RJ-45
socket labeled ISDN on the Live50 board.

2. Plug the other end of the cable into the network service jack.

From a Network Interface board

Restarting Your
PC

If you are connecting to a network using an optional network
interface board, refer to Appendix C for specific information about
your connection.

After you connect all of the Live50 components and connect your
system to the network, power on your PC.

You're now ready to install the PictureTel Live software. Refer to
Chapter 4 for software installation instructions.
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Installing
Picturelel Livel100
Hardware

Overview This chapter explains how to install the PictureTel Livel00 required
and optional hardware. If you are not familiar with configuring and
installing PC boards, arrange for an experienced person to do the
installation for you.

Note: If you are installing the Live50 product, refer to Chapter
2, Installing PictureTel Live50 Hardware

In this Chapter

This chapter covers the following required ([_])and optional ([])
hardware installation steps:

Step Topic Page

1 Checking Your PC Settings 3

2 Opening Your PC 4

3 Installing the VGA Video Board 5

4 Installing the Audio Communications 6
Board

5 Connecting the Live100 Boards Together 7

6 Installing Optional Network Interface 8
Boards

7 Attaching Labels 8
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INSTALLING PICTURETEL LIVE100 HARDWARE

Step Topic Page

8 Closing Your PC 9

9 Reconnecting Cables 9

10 Connecting the FlipCam Camera 10
11 Connecting the Speakerphone Unit 12
12 Connecting Optional Equipment to the 14

Speakerphone

13 Connecting to the Network 15
14 Optional Devices 16
15 Restarting Your PC 18

3-2



Checking Your PC Settings

Checki ng Your Before installing the PictureTel Livel00 hardware, you must confirm
P which IRQ, I/O port address, and shared memory settings are
PC Settlngs available for the Livel00 boards to use.

1. Begin by checking your PC documentation, then check the
manufacturer’s documentation for settings used by any devices
you have added to your PC, such as:

o SCSI devices
o LAN cards
o Modems

Q Scanners

o Sound cards

2. As you check the manufacturer’s default settings, check to see if
you changed any of their default settings.

3. If your PC has an ISA bus, you can then run the Microsoft
Diagnostics program, as described in Appendix A, to check your
PC settings.

Note: Keep in mind that the Microsoft Diagnostics
program may not always report every setting that is
in use. The most accurate way to determine the
settings that are in use, is to check the
manufacturer’s documentation.

4. Write down the settings that are already in use.
5. Compare your list of settings that are in use with the default
settings for the Live100.
The default PC settings for the Live100 are:
e IRQ 11 (audio card)
e [/O port address
— 0280 (audio card)
— 27CA-27CE (VGA video board)
e Shared memory space DO00-D3FF

If you are installing optional network interface boards, refer to
Appendix C, Installing Network Interface Boards for additional
IRQ and I/0 port address default settings.
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Opening Your PC

6. If there is a conflict, change the corresponding switch settings in

your Live100 boards, as described in Appendix B.

To open your PC and prepare it for the Livel00 boards, follow these
steps:

Note: For BABT (British Approvals Board for

Telecommunications - United Kingdom) and AUSTEL
(Australia) requirements for installing the Live1l00
board, refer to Appendix H.

. Power off your PC.

Leave your PC connected to the power source to provide a
ground connection.

. Disconnect your monitor cable, and other cables if necessary,

from the PC chassis.

. Remove the chassis cover.

Refer to your PC documentation for instructions.

. Remove your VGA board if it is a separate board, or disable VGA

on the motherboard.

Refer to your PC documentation for instructions on how to
disable VGA on the motherboard.

. Locate two adjacent full-size expansion slots.

One of these can be the expansion slot from which you removed
your VGA board.

Note: If you are installing additional Live100 network
interface boards, locate slots for them as well. The
additional boards must not be more than one slot
away from the Live1l00 Audio Communications
board.

. Remove the back plates of your selected expansion slots and save

the screws.



Installing the VGA Video Board

|nsta||ing the To install the VGA Video board, follow these steps:
VGA Video Board 1. Remove the VGA Video board from its plastic antistatic package.

Caution

A The VGA Video board can be damaged by static discharge.
To equalize static charge, ground yourself by touching the
metal back panel of your PC.

You can identify the VGA Video board by the 15-pin VGA
connector on the back plate.

Interboard connector Back plate

""' iy
l
I connector

Insert into the
PC’s expansion slot

2. Insert the board into the selected expansion slot.

Make sure the board is securely seated in its slot.

3. Secure the board by replacing the screw that holds the back plate.
Note: The VGA drivers for your video board need to be
installed after you have finished with the Live100

hardware installation. Refer to Chapter 4, Installing
PictureTel Live Software for installation instructions.

3-5



INSTALLING PICTURETEL LIVE100 HARDWARE

Installing the To install the Audio Communications board, follow these steps:
Audio 1. Remove the Audio Communications board from its plastic
Communications antistatic package.

Board

AN

Note: The default switch settings are explained in Appendix B,
Changing Settings on the Livel00 Boards.

Caution

The Audio Communications board can be damaged by
static discharge. To equalize static charge, ground yourself
by touching the metal back panel of your PC.

You can identify the Audio Communcations board by the MVIP
connector on the top edge.

Interboard MVIP connector
connector for optional boards Back plate

3-6
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l TE L TR

Insert into the
PC’s expansion slot

..

m

2. Insert the board into the expansion slot adjacent to the VGA Video
board.

Make sure the board is securely seated in its slot.

3. Secure the board by replacing the screw that holds the back plate.



Connecting the Livel00 Boards Together

onnectinag the To connect the two Livel00 boards together, use the supplied ribbon
g g PP
Live100 Boards cable, and follow the directions below.
Together
Ribbon cable Interboard connector

Audio Communications
board

VGA Video
board

To connect the boards together, follow these steps:

1. Grasp the connector on one end of the ribbon cable so that you
can squeeze the tabs along the sides.

2. Line up the key on this connector with the interboard connector on
top of one of the Live100 boards.

Caution

the cable to the Livel00 boards, be careful not to damage the
pins.

ﬁ The ribbon cable has 100-pin connectors. When you connect

3. Slide the key into the interboard connector while squeezing the
tabs, keeping the top of the connector parallel with the top of the
board.

4. Click the tabs into the locks on the sides of the interboard
connector.
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5. Repeat these steps to connect the other end of the ribbon cable to

the other board.

|nsta||ing If you are not using an ISDN connection, you have several network
Optional Network connection options that require installing one or more network

Interface Boards

interface boards. The following table identifies the appropriate
network interface board for each type of network connection. Refer

to Appendix C, Installing Network Interface Boards for a complete
description of the installation process.

If you need this
conneciton type:

The required hardware boards are
listed here:

ISDN (BRI)

No optional network interface boards are
required.

(Consult your telephone provider to
determine if a network termination device
(NT1) is required.)

Integrated 4-Wire SW56

Switched-56 Network Interface

V.35 (or RS-449) dialed/
nondialed

DDM /Network Interface

Note: For V.35 and RS-449 connections, CSU/DSUs (Channel
Service Unit/Data Service Units) may be required
between the PC and the telephone company’s digital
network connection. Your installation may already have
these devices in place. Consult your telephone company

representative.

Attachi ng Labels After you have installed the Live100 boards, attach labels to your PC

by following these steps:

1. Locate the sheet of labels for the Live100 boards.

2. Peel off the label that includes the “VGA” marking.

3. Attach this label to your PC chassis to the left of the VGA Video
board, with the triangle at the top and pointing toward the board.




Closing Your PC

4. Peel off the label that includes the “ISDN” marking.

5. Attach this label to your PC chassis to the left of the Audio
Communications board, with the triangle at the top and pointing
toward the board.

i Audio
VGA Q’égfg Communications

| bloard

ISDN

VCR/Audio

Aux. Speaker
& Mic.

Speakerphone

To the monitor A
(connector labeled VGA) ~ Main Cam

VCR or other aux. video device
(connects to VCR’s video out)
Second FlipCam

Closing Your PC After you install the Live100 boards and attach the labels, replace
the chassis cover on your PC. Refer to your PC documentation for
instructions.

Reconnecting Reconnect the cables you disconnected earlier from your PC:
Cables

1. Connect your monitor cable to the 15-pin connector labeled VGA
on the VGA Video board.

2. Reconnect any other PC cables you disconnected earlier.
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Con necting the This section tells you how to:
FlipCam Camera a Connect the FlipCam camera to your PC
0 Mount and position the camera
Caution
A Do not connect or disconnect Livel00 components when
your PC is on. Doing so may damage the Live100 hardware.

Connecting the FlipCam to the PC
To connect the FlipCam to the VGA Video board in your PC, follow
these steps:

1. Tilt the camera body up and away from its circular base, as shown
below.

Ferrite Bead

\

eoom|

—1L]

VGA Video board

C——=

N

(8A) socket

Cable guide

2. Locate the 8-pin FlipCam cable, with plugs labeled 8A).

The cable has a ferrite bead near one end.
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Connecting the FlipCam Camera

Caution

The cables for the speakerphone unit and the FlipCam are
similar, but they are not interchangeable. The end plugs on
the FlipCam cable are labeled and the plugs on the
Speakerphone cable are labeled (7). If you connect the
wrong cable, you might damage the Live1l00 components.

Be careful when you connect or disconnect the cable. When
connecting it, be sure the flat side of the plug lines up with
the flat side of the socket, as shown by the socket label.
When disconnecting it, be sure to release the collar lock by
pulling on the plug’s collar, not on the cable.

3. Plug the end of the cable without the ferrite bead into the socket at
the back of the camera near the hinge.

Both the plug and the socket are labeled (8A). Push the plug
securely into the socket.

4. Press the cable into the guide on the camera base.

5. Be sure your PC is turned off.

6. Plug the end of the cable with the ferrite bead into the socket
nearest the VGA connector on the VGA Video board.

Both the plug and the socket are labeled (8A). (The socket
farthest from the VGA connector is also labeled 8A); that
socket is for a second camera.)

Push the plug securely into the socket.

Mounting and Positioning the FlipCam

The FlipCam camera is designed with flexibility in mind. You can
mount it in several ways, and you can quickly switch from one
mounting option to another.
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Connecting the
Speakerphone

Unit

3-12

N

You have two options for mounting the camera:
0 You can mount the camera on a standard camera tripod.

The camera base has a standard-size threaded hole for tripod
mounting. You attach it to the tripod as you would any other
camera.

0 You can set the camera on any flat, secure surface.

If you're using this camera as your main camera, place it on top
of your video monitor. For other uses, you can place it on a
secure shelf or tabletop.

The camera base has a rubber surface to keep it from slipping.

In addition, PictureTel offers an optional document stand that
allows the FlipCam to switch to a downward focus to view
documents on a flat desktop. Refer to Appendix I for ordering this
optional camera stand.

To connect the speakerphone unit:

1. Be sure your PC is turned off.

Caution

Do not connect or disconnect Livel00 components when
your PC is on. Doing so may damage the Live100 hardware.

2. Locate the 7-pin speakerphone unit cable, with plugs labeled (7) .



Connecting the Speakerphone Unit

Caution

The cables for the speakerphone unit and the FlipCam are
similar, but they are not interchangeable. The end plugs on
the FlipCam cable are labeled and the plugs on the
Speakerphone cable are labeled (7). If you connect the
wrong cable, you might damage the Live1l00 components.

Be careful when you connect or disconnect the cable. When
connecting the cable, be sure the flat side of the plug lines
up with the flat side of the socket, as shown by the socket
label. When disconnecting the cable, be sure to release the
collar lock by pulling on the plug’s collar, not on the cable.

3. Plug one end of the speakerphone cable into the socket labeled
(7) on the speakerphone unit, aligning the plug carefully.

The drawing below shows the location of the socket.

Communications
board

4. Plug the other end of the speakerphone cable into the socket
labeled @ on the Audio Communications board, aligning it
carefully.
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5. Plug one end of the handset cable into the socket farthest to the
right on the back of the speakerphone unit, labeled f .

6. Plug the other end of the handset cable into the handset.

Connecting You can connect two optional pieces of equipment (available
Optional through your PictureTel distributor) to the speakerphone unit:

H 0 A headset, to allow free use of your hands during a
Equipment to the y &
Speakerphone videoconference while retaining privacy

o A power supply, for extra volume from the speakerphone

The figure below shows the sockets for optional equipment on the
back of the speakerphone unit.

Power In

Connecting the Headset

To connect the optional headset to the speakerphone unit, plug
the headset cable into the speakerphone unit socket labeled with
the headset icont ).
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Connecting the Power Supply

If you plan to use the speakerphone in a large room or if your PC is
not providing sufficient power for quality audio, you may choose to
use the optional power supply.

To connect the optional power supply, follow these steps:

1. Plug the power supply cable into the power socket labeled =%/
on the back of the speakerphone unit.

2. Plug one end of the power cord into the power supply.

3. Plug the other end of the power cord into a wall outlet.

Con necting to The Livel00 connection to the network is made from a socket in the

the Network network interface board to a network service jack. To connect your
PC to the network, follow the procedure below for the network
interface board you have previously installed.

From the Live100 Audio Communcations Board

If you are connecting directly into an ISDN BRI network, using the
Livel00 audio communications board, follow these steps:

1. Plug one end of the 8-pin modular network cable into the RJ-45
socket labeled ISDN on the Audio Communications board.

2. Plug the other end of the cable into the network service jack.

From a Network Interface board

If you are connecting to a network using an optional network
interface board , refer to Appendix C for specific information about
your connection.
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Optional Devices You can connect a second FlipCam camera and a VCR or other video
source to your PictureTel Livel00.

To connect audio input and output devices to the Live100
components, you need an optional Auxiliary Audio cable (refer to
Appendix I to order from PictureTel). To use a VCR for recording a
videoconference, you need a third-party scan converter.

The figure below shows the location of the sockets on the Livel00
boards that you use to connect optional devices.

i Audio
VGA Q’égfg Communications

| bloard

ISDN

VCR/Audio
Aux. Speaker
& Mic.

Speakerphone

To the monitor L
(connector labeled VGA) ~ Main Cam

VCR or other aux. video device
(connects to VCR’s video out)
Second FlipCam
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AN\

AN

Connecting a Second FlipCam Camera

To connect a second FlipCam camera to your PictureTel Livel00,
follow these steps:

1. Be sure your PC is turned off.

Caution

Do not connect or disconnect Livel00 components when
your PC is on. Doing so may damage the Live100 hardware.

. Plug the camera cable into the socket labeled |8A that is farthest

from the 15-pin VGA connector for your PC monitor.

. To enable the camera, power on your PC, bring up the PictureTel

Live application, and from the Tools menu choose Preferences.
Choose the Cameras category and assign a name to the second
FlipCam camera and select OK.

Connecting a VCR or Other Video Source

To connect a VCR or other composite video source (such as a
camcorder) to the Livel00 boards, follow these steps:

1. Be sure your PC is turned off.

Caution

Do not connect or disconnect Livel00 components when
your PC is on. Doing so may damage the Live100 hardware.

. Plug the VCR video-out cable into the yellow video-in socket

labeled <> on the VGA Video board.

Use a cable with an RCA connector.

. Plug the Auxiliary Audio cable into the socket labeled | 3) or @on

the Audio Communications board.

. Plug the VCR audio-out cable into the audio-in socket @ on the

Auxiliary Audio cable.
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5. Plug the VCR audio-in cable into the audio-out socket @ on the
Auxiliary Audio cable.

Restarti ng Your After you connect all of the Live100 components, power on your PC.
PC You're now ready to install the PictureTel Live software.
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4

Installing PictureTel
Live Software

The PictureTel Live software can be installed after you have
completed your PictureTel Live hardware installation. If you are not
familiar with installing software in a Windows environment you
should have an experienced person install the software for you.

In this Chapter

This chapter covers the following major topics:

Topic Page
General Considerations 2
Installing from a LAN 3
Installation Steps 4
Installing the VGA Driver 5
Starting the Setup Wizard 10
Installing LiveShare Plus 11
Installing the PictureTel Live Application 13
Locating PictureTel Live Files 20
What To Do Next 21
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General
Considerations

During the installation, the PictureTel Live setup program creates a
directory (C:\PICTEL\PCS), by default, for the PictureTel Live and
LiveShare Plus software and copies the files into that directory.

During setup, you'll enter information about the PictureTel Live 50
or Livel00 board configurations and your videoconferencing
network interface.

If you are using ISDN BRI (basic rate interface), make sure you have
the following information from your network provider (telephone
company or telecom group) before you run the PictureTel Live setup
program:

o The ISDN signaling protocol (referred to as switch type)

0 Your Service Provider Identification (SPID) numbers

0 Your Multiple Subscriber Numbers (MSN), for switches outside
the USA and Canada, that allow multiple terminals on a single
line

0 Your Local Directory Numbers (LDN), for switches inside the
USA and Canada, that allow multiple terminals on a single line



Installing from a LAN

n in rom ou are installing Picturelel Live software in several Live systems

Installing from a Ify installing PictureTel Live sof i ILive sy

LAN connected to a LAN, you can install the software from the LAN
rather than from disks. Just follow these steps:

1. Create installation directories on a convenient hard disk.

On a hard disk accessible to all the Live, create the directory
structure illustrated below.

E\
VGA
|
VGA Video Drivers
Live
l L _

] F;
3

Live 50 or 100

> LivePIus1
T T —’:2

or 3

Liveshare Plus LiveShare Plus
for Win3.1x for Win 95

2. Copy the installation disks to the new directories.
Copy all the files from the first installation disk to the 1 directory,
from the second disk to the 2 directory, and so on.

3. Use these directories in place of the installation disks.

As you follow the instructions in the rest of this chapter, use the
directories in place of the installation disks.

For example, when you are ready to run the Setup program,
instead of using a pathname like

a:\setup
use one like
e:\live\1\setup
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Installation Steps To install the complete Live application the following installation
order is recommended.

Step1.) [

VGA Video Drivers

Step 2.) ‘

Installing PictureTel LiveS0 ‘

Video Driver Installed
LiveShare Plus Not installed
PictureTel Live50 Mot ready to be installed

Install Path: | A:\ D[ ]

LiveShare Plus is not installed.

If you want to install LiveShare Plus, insert the
correct disk and press the 'OK' button. You
canhot continue until LiveShare Plus is
installed.

Running the PictureTel Live Setup Wizard

Step 3.) |
|
or
LiveShare Plus LiveShare Plus
for Win3.1x for Win 95
Step 4.) |
L]
Live

1. The correct VGA Video Drivers for your PictureTel Live hardware
need to be selected and installed.

2. Insert the Live Disk 1 and run a:\setup to initiate the Setup Wizard.
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Installing the
VGA Driver

3. Install the Windows 3.1 or the Windows 95 version of LiveShare

Plus. (After this install, Windows will be restarted.)

4. Install the PictureTel Live application. (After this install, Windows

will be restarted.)

The VGA driver you need to install depends on which Live system
you are installing and which Windows operating system you are
running. There are four different VGA driver installation/selection
procedures described below that should address your specific
installation requirements. Choose one of the following procedures
to install your VGA drivers:

o If you are running Windows 3.1x, and you have installed the

PictureTel Livel(0 system, or the Live50 system with a
PictureTel VGA board for an ISA bus, refer to the Windows 3.1x
PictureTel VGA Driver Installation procedure described below.

If you are running Windows 95, and you have installed the
PictureTel Livel(0 system, or the Live50 system with a
PictureTel VGA board for an ISA bus, refer to the Windows 95
Driver Selection procedure described below.

If you are running Windows 3.1x, and you have installed the
PictureTel Live50 system with a Matrox® or Compaq QVision®
VGA board for a PCI bus, refer to the Windows 3.1x Non-
PictureTel VGA Driver Installation procedure described below.

If you are running Windows 95, and you have installed the
PictureTel Live50 system with a Matrox® VGA video board,
refer to the Windows 95 Matrox Driver Installation procedure
described below.

Note: When you install the VGA drivers, set the screen

resolution to 1024 x 768 (no higher) at 60 Hz and select
256 or more colors.

Windows 3.1x PictureTel VGA Driver Installation

PictureTel provides the VGA drivers necessary for Livel00 systems
and Live50 systems using the PictureTel VGA board for an ISA bus,
running in a Windows 3.1x operating system. For Windows 95
systems, do not install the drivers provided on the VGA disk,
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instead, perform the Windows 95 Driver Selection procedure
described below.

To install the appropriate driver from the Windows 3.1x desktop,
follow these steps.

1.

10.
11.

Open the Main program group and select (double-click) Windows
Setup

Windows displays the Windows Setup window.

. From the Options menu, select Change System Settings...

Windows displays the Change System Settings window.

. Click on the Display bar or on the down arrow next to the Display

bar.

A scrollable list of display drivers appears.

. Press the down arrow until you highlight Other display (Requires

disk from OEM)..., and press Enter.

. Insert the disk labeled VGA Driver into the diskette drive.
. Enter the appropriate drive at the prompt and press Enter.

. Highlight the VGA driver you want to use and press Enter.

The VGA driver you select must match the resolution of your
PC monitor. If you don’t know the resolution of your monitor,
refer to your PC documentation.

When you select a VGA driver and press Enter, a confirmation
screen appears displaying your selected driver.

. Press Enter to accept your selected VGA driver.

. Close the windows and return to the desktop

Remove the VGA disk from the diskette drive.

Open a Windows application to verify that the VGA board is
working properly.

If your selected setting causes your video display to appear
distorted, you need to run the setup program again and try a lower
resolution. This happens when the video display chip on your VGA
board is incompatible with your selected setting.
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After you verify that the VGA board is working properly, follow the
instructions in the next section for using the SetupWizard.

Windows 95 Driver Selection

For Livel00 systems, or Live50 systems using the PictureTel VGA
board for an ISA bus, running in a Windows 95 operating system,
perform the following Windows 95 Driver Selection procedure:

1. Click on the Start button, point to Settings, and click on Control
Panel.

. Double click on the Display icon.

. Click on the Settings tab page.

. Click on the Change Display type button.

. Click on the Change button in the Adapter Type area.

. Make sure the Show all devices setting is selected.

N S A W N

. Select Tseng Labs from the Manufacturers area and the Tseng
Labs ET4000 /W32 driver from the Models area of the window.

8. Click OK to apply the change.

You are prompted to restart your computer to apply the changes to
the display settings.

9. Open a Windows application to verify that the VGA board is
working properly.

If your selected setting causes your video display to appear
distorted, you need to run the setup program again and try a lower
resolution. This happens when the video display chip on your VGA
board is incompatible with your selected setting.

After you verify that the VGA board is working properly, follow the
instructions in the next section for using the Setup Wizard.
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Windows 3.1x Non-PictureTel VGA Driver Installation

If you are installing a Live50 system with a Matrox® or Compaq®
QVision VGA board for a PCI bus and you are running Windows
3.1x, then you need to follow the installation instructions provided
specifically for that VGA video board.

1. Run the Setup program provided by the video board manufacturer.

2. After you have completed the installation, remove the VGA
installation disk from the diskette drive.

3. Open a Windows application to verify that the VGA board is
working properly.

If your selected setting causes your video display to appear
distorted, you need to run the setup program again and try a lower
resolution. This happens when the video display chip on your VGA
board is incompatible with your selected setting.

After you verify that the VGA board is working properly, follow the
instructions in the next section for using the Setup Wizard

Windows 95 Matrox Driver Installation

If you are installing a Live50 system with a Matrox® VGA board for
a PCIbus and you are running Windows 95, then you need to follow
this installation procedure. This procedure consists of three main
steps:

1. Installing the Microsoft MGA Driver 1.0 (available as part of
Windows 95)

2. Installing the MGA PowerDesk upgrade (disk supplied with
PictureTel Live50, Version 1.6)

3. Adjusting the “Desktop Area” and “Display Area.”

Step 1: Installing the Microsoft MGA Driver

You may have installed a new Matrox VGA board as part of the
Live50 hardware installation, or your Matrox board may have been
installed from a previous version of Live50 (formerly PCS 50). In
either case when Windows 95 is first started with the Matrox board
installed, Windows 95 acknowledges the Matrox VGA board and
automatically installs the Microsoft MGA 1.0 driver.
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Step2: Upgrading to the PowerDesk Driver

From the Windows 95 installed MGA 1.0 driver, you need to
upgrade to the Matrox “PowerDesk” driver.

To complete the upgrade, follow these steps:

1.

2.
3.

7.

Insert the Matrox PowerDesk disk into Drive A:
From the Start Menu, run A:\SETUP.EXE

Confirm the installation path (C:\MATROX\MGA), or modify it, and
press Next.

. Confirm the installation of both the MGA Monitor Program and

Quick Access by pressing Next.

. If amessage indicating that MGA.INF has been found is displayed,

respond Yes to the questions, “Do you want to use the Win95
monitor mechanism instead.” If the MGA.INF could not be found,
press OK and continue.

Files will be copied to your hard disk.

. A “wizard” leads you through the process of selecting the updated

MGA driver, using the standard Windows 95 Display Settings
dialog.

Restart the PC.

Step 3: Adjusting Desktop Area and Display Area

If the display area exceeds the desktop area ( for example, you need
to move the cursor to the edges in order to pan the display), you
need to perform the following steps:

1.

Click on the Start button, point to Settings, and click on Control
Panel.

. Double click on the Display icon.
. Click on the MGA Settings tab page.

. Set the Desktop area to match the Display area (for example, 1024

X 768).

. Click OK to apply the changes.
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Starting the
Setup Wizard
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After you verify that the VGA board is working properly, follow the
instructions in the next section for using the Setup Wizard.

The Installation of PictureTel Live software is guided by a Windows
wizard. The wizard identifies any component that has been installed
(such as the VGA Video Drivers) and directs you to install the
remaining components that make up the complete installation:

o LiveShare Plus application
a Live application

When running, the wizard displays a message area to inform you of
the status of each installation component and the necessary actions
to complete each part of the installation.

Before you begin the installation, your PC must be displaying the
Windows 3.1x or Windows 95 desktop.

To initiate the PictureTel Live Setup Wizard, run the setup program
that initiates the Setup Wizard by following these steps:

1. From either the Windows 3.1x Program Manager or the Windows
95 Start Menu, select the Run ... program.

Windows displays either the 3.1x Run dialog box

=-| Hun

Command Line:

| | Cancel

(] Run Minimized Browse._ .




Installing LiveShare Plus

Installing
LiveShare Plus

or the Windows 95 Run dialog box.

Run

Type the name of a program, folder, or document, and

Windows will open it for you.

Open: I

Lo |

Cancel |

=~

Browse. . |

2. Insert Disk1 :SETUP of the Live 50 or 100 installation disks, and

enter a:\setup in the Run dialog box.
Windows initiates the Live Setup Wizard.

Setup Wizard

Installing PictureTel Live50

Video Driver
'LiveShare Plus
PictureTel Live50

Installed
Mot installed
Not ready to be installed

Install Path: | A:\ | oK

LiveShare Plus is not installed.

If you want to install LiveShare Plus, insert the
correct disk and press the 'OK' button. You
cannot continue until LiveShare Plus is
installed.

The LiveShare Plus application comes in two different versions, one
for Windows 3.1x, and one for Windows 95. Make sure you follow
the installation instructions for the version that matches your

operating environment.
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Install LiveShare Plus locally on each PC; do not install it on
network drives.

Installing LiveShare Plus On Windows 3.1x and Windows 95
To install LiveShare Plus from the Setup Wizard:

1. Insert LiveShare Plus diskette 1 into the diskette drive (a: or b:).
2. Set the Install Path to read from the correct diskette drive.

3. Select (double-click) LiveShare Plus from the Wizard’s display box.
LiveShare Plus setup begins.

4. Follow the instructions that appear on the screen.

5. When the Choose Destination Location box appears, you can
enter a custom installation location or click the Continue button to
accept the default location.

Only install LiveShare Plus on your local hard disk. Do not
install it on a network drive or on a removable disk drive.

When the installation is complete, the setup program displays a
finished message and initiates the Do you want to restart the
computer dialog.

6. Before you restart the computer, remove the diskettes from the
drive.

7. When installation is complete, store your LiveShare Plus diskettes
in a safe place.
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Installing the
PictureTel Live
Application

To install the PictureTel Live application from the Setup Wizard,
perform the following steps:

1. Insert DISK 1: SETUP of the Live50 or Live 100 Installation disks in
drive a: or b: and enter a:\setup or b:\setup in the Run dialog box
to run the Setup Wizard.

Setup Wizard

Installing PictureTel Live50

Video Driver Installed

LiveShare Plus Version 3.0.0
PictureTel Live50 Ready to be installed

Install Path: [a:\setup | | oK

All components required for PictureTel Live50
are installed.

Press the 'OK' button to install.

Exit |

2. Select (double-click) PictureTel Live (double-click) from the
wizard’s display box.

3. Fill in your name, your company, and the serial number of your
PictureTel Live unit and press enter.

You can find the serial number on the product registration card,
which is shipped with the PictureTel Live documentation.

The setup program displays a confirmation window.
4. If the information is correct, press enter (or click the Yes button). If

the information is incorrect, click the No button and make the
corrections.

Setup displays the Installation Path window.

The default drive and directory are C:\PICTEL\PCS. You can
accept the default or change this information by typing a
different name.
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5. Press enter (continue) to keep the default drive and directory or

change them to be compatible with your standards.

The Setup program creates the directory for the PictureTel Live
application and will later copy all but two files into this
directory. (See Locating PictureTel Live Files on page 4-20.)

If an existing version of Live is currently installed and this
directory already exists, the setup program allows you to
override it and continue the upgrade installation, choose a
different directory, or cancel this setup program.

After the directory path is confirmed, setup begins a dialog that
allows you to enter network interface informaton.

. Setup displays the following window with the network interface

choices your PC will use for videoconferencing.

= Network Interiace Setlings

Please select the type of network interface(s) to
é be used for videoconferencing at your PC.
Network interfaces other than ISDN BRI require
additional boards.

X
Additional Network Interfaces:

@ None

() Switched 56

() v.35/RS-449 dialed

OV.BS,"RS—MQ non-dialed (dedicated)

| Continue I | Back I | Exit I | Help I

If you enabled ISDN, the dialog will ask you for the information
described in the following paragraphs.

If you enabled Switched 56, V.35, or RS-449, you will be asked
for the IRQ and I/O Port Address settings of the network
interface board you have previously installed. Then you can go
to Step 10.
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ISDN Protocol

There are different ISDN protocols in use throughout the world, and
your Live system must be configured to operate with the specific
protocol that your network uses.

The protocol depends on the country where you are using the Live,
and whether you are connected to a public or a private network.

The Setup program displays a list of countries; if only a single switch
type is supported in the public network in a country, then only the
name of the country appears in the list. If multiple switch types are
supported in a country, then each switch type for that country is
listed.

Selecting an ISDN protocol

If you are connected to a public network, and your country appears
on the list only once, select that list item.

If you are connected to a public network in one of the following

countries, you should select Europe: Euro-ISDN:
0 Austria

Denmark

Finland

Greece

Hong Kong

Ireland

Italy

Luxembourg

Netherlands

Portugal

Spain

Sweden

United Kingdom

T 1 T 1 I I o  E N

If you are connected to a public network in France and you have
installed the Livel00 system, you have the following choices:

o Euro-ISDN
a VN3

Live50 users in France must select Euro-ISDN.
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If you are connected to a public network in Germany and you have
installed either the Live50 or Live100 system, you have the
following choices:

o Euro-ISDN
a ITR6

Note: If you are connected to a private network, or if your
country appears on the list more than once, or if your
country does not appear in the list displayed by the
Setup program, and is not in the list of countries that use
Europe: Euro-ISDN, you must contact your network
service provider to determine which protocol you
should select during installation.

7. Enter the Service Provider IDs (SPIDs) for the B channels (in the
United States and Canada only)

On fully-initializing switches (this includes 5ESS CUSTOM
Multipoint, DMS CUSTOM Multipoint, and National ISDN (NI-
1)) in the United States and Canada, you must enter the SPIDs
assigned to you by your network provider. Unless these items
are entered correctly, you will not be able to make or receive
calls.

8. Ifyou are connecting your Live system to an ISDN network outside
of North America, you may need to specify the "Number Type" and
"Number Plan" used by that network.

This is done when you specify the ISDN protocol. The pull-
down menus which allow you to specify the Number Type and
Number Plan appear only if needed.

If you do not know the proper settings, you can attempt to
proceed with the installation using the default values. If you
then have difficulty originating or receiving calls, contact your
service provider to determine the proper Number Type and
Number Plan, and run the PictureTel Live Configuration
program to configure your system accordingly.

9. You need to specify the Multiple Subscriber Numbers (MSNs) for
those switches outside the United States and Canada that permit
multiple terminals, each with a unique set of ISDN phone numbers,
to be connected to a single line. For such switches inside the
United States and Canada, you need to specify the equivalent
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10.

Local Directory Numbers in these boxes. If you do not specify the
Local Directory Numbers for calls inside the United States and
Canada, you will not be able to receive calls.

In order to allow your Live system to respond only to those
incoming calls which are intended for it, you must specify the
MSNs or LDNs which will differentiate your Live from all other
terminals on the line.

In the next window you must specify the PC settings for the Live
board.

The default settings are:

Setting Default
IRQ 11
1/0 port address 280
memory space address | D000 through D3FF

Refer to Appendix A to check that these default settings do not
conflict with other settings already used in your PC.

Note: If you have trouble bringing up DOS and Windows
or starting up PictureTel Live after you install the
software, refer to Chapter 5, Troubleshooting, and
then run the Setup program again to manually
change the settings.

Write down the settings here for future reference:
IRQ:

I/0O port address:
Shared memory space address:

The Setup program automatically selects the video input format
based on the country ISDN switch, either : PAL (Phase Alternate
Line) for Europe or NTSC (National Television Standards
Committee) for North America and Japan.

You can override the selection if the setup program selects the
wrong format.
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11. Specify a node name that identifies you and your PictureTel Live
system to the other party during videoconferences

The name can contain up to 32 characters and can include
spaces. You can use your own name or any other name to
identify yourself and your PC.

12. If you are installing the Live50 software, the setup program
performs an additional step and verifies your video board.

Note: This step is for the Live50 software installation only.

You have the option of accepting the video card Setup has
detected (Yes), or selecting another card by responding No and
initiating the board selection box dialog. We recommend you
accept the video card Setup has detected. If a problem occurs
you can choose another selection.

At this point, the basic installation is over and setup responds by
transferring the files from the installation disks to your hard drive
and giving you the option of modifying your config.sys file to
prevent an extended memory manager from using specific address
space reserved for Live operations.

Reconfiguring Memory (optional step)

If you are using an extended memory manager, such as EMM386
(which is shipped with Microsoft DOS or Windows) or a third party
manager, you need to configure the extended memory manager to
exclude the memory region that is used by your PictureTel Live
software.

The PictureTel Live Setup program allows you to edit the line in
your CONFIG.SYS file, which configures the extended memory
manager, by displaying an edit window in which you can make the
appropriate changes.

Note: If you are sure that you do not have an extended
memory manager installed in your PC, or if you are not
upgrading from a previous version of PictureTel Live
and have not changed the memory address, you do not
need to make the following change.

Be sure to refer to the documentation for the memory manager
installed in your PC for the exact syntax of the exclude statement
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before modifying your CONFIG.SYS file. For example, if your
extended memory manager is EMM386, refer to your DOS manual
for the statement format.

The memory region which must be excluded begins at the address
you entered earlier in the installation. If you accepted the default
value, then the memory region begins at D00O.

The address at which the memory region ends is the starting address
plus 3FF. If you accepted the default value, then the memory region
ends at D3FF.

For example, if you are using the EMM386 extended memory
manager, you must edit the line in your CONFIG.SYS file in which
EMM386 is configured to include the statement:

x=D000-D3FF

1. Edit your CONFIG.SYS file to add an exclude statement to the line
defining your extended memory manager.

2. Allow the Setup program to reboot your PC.

The Setup program automatically reboots your PC and restarts
Windows.

3. Once Windows has restarted, you may need to re-optimize your
system, using your extended memory manager’s optimization
program.

For example, if you use EMM386, you now need to run the MS-
DOS 6.0 Memmaker program.

If Windows fails to restart correctly, you probably need to select
a different combination of IRQ, I/O, and memory address
settings. Refer to Chapter 5, Troubleshooting.

Verifying Your Installation

After installing PictureTel Live, you can run a simple test to confirm
that it is working properly.

1. Start PictureTel Live.
If you can’t start PictureTel Live, follow these steps:
a. Exit Windows.
b. Turn your PC off, and then on.
¢. Start Windows.
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Locating
PictureTel Live
Files
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d. Attempt to start PictureTel Live.
If the Live application is still not working properly, then
refer to Chapter 5, Troubleshooting.

2. Check your Local Video window to make sure that you can see the
video image captured by your local video camera.

3. Choose Diagnostics from the Tools menu.

4. Click the Loopback button.
After a delay of several seconds the Loopback test begins.

Once the test begins, you should observe a delay of about one
second between moving and seeing the motion in your video
image, and between speaking and hearing your speech.

You can adjust the volume of the speaker using the scroll tool to
the left of the test mode video image.

5. Click the hangup (or end test) button.
If the Loopback test is unsuccessful, a message may be
displayed at the bottom of the remote video window.

6. Verify your Network connection. You should see the Ready
message displayed at the bottom of the remote video window.

If you see the “Network Down” message, then there is a
problem with the network. Refer to Chapter 5, Troubleshooting.

The PictureTel Live Setup program installs all but two PictureTel
Live files in the directory that you specified. For example, if you
accept the default directory, the Setup program installs the
PictureTel Live software in C:\PICTEL\PCS.

The Setup program installs these files in the C:\WINDOWS
directory:

o PCS100.INI
o VCSWIN.INI



What To Do Next

In addition, the Setup program saves the following files before
modifying them:

This File: Is Saved Before Modification
As:

CAWINDOWS\SYSTEM.INI CAWINDOWS\SYSTEM.PCS

CAWINDOWS\WIN.INI CAWINDOWS\WIN.PCS

What To Do Next You're now ready to refer to the PictureTel Live User’s Guide to learn
how to use the system.

4-21






5

Troubleshooting

Overview This chapter helps you troubleshoot problems that can occur during
installation.

Note: If you have problems during normal operation of
PictureTel Live, refer to the troubleshooting chapter of
the Picturelel Live User’s Guide.

In this Chapter

This chapter covers the following major topics:

Topic Page
Problems Bringing Up DOS and Windows 2
Problems Starting Up PictureTel Live 4
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Problems
Bringing Up DOS
and Windows

If Windows fails to start after you have installed PictureTel Live, you
probably need to select a different combination of IRQ, I/O and
memory addresses for the PictureTel Live system. Refer to
Appendix A “Checking Your PC Settings” for information on
choosing an appropriate combination.

PictureTel Live Setup modifies the SYSTEM.INI and WIN.INI files
in your Windows system directory. In order to restart Windows, you
will need to replace these files with their original versions. Do this
to restore the original versions which were saved by PictureTel Live
Setup:
1. Change to the directory containing your Windows system files.
Typically, this is:
C:\WINDOWS

2. Replace the new versions of the system files with the original
versions of the files, by entering the following commands:

COPY /Y SYSTEM.PCS SYSTEM.INI
COPY /Y WIN.PCS WIN.INI
3. Reboot your PC.

If you still encounter problems bringing up DOS and Windows,
refer to the instructions in Table 5-1 on page 5-3.



Problems Bringing Up DOS and Windows

Table 5-1:

Problems Bringing Up DOS and Windows

Problem

Possible Cause

Possible Solution

Monitor is blank. You see no DOS
prompt.

You monitor is plugged into the
motherboard VGA port.

Plug the monitor into the PictureTel VGA
card.

You have not removed or disabled your
former VGA subsystem.

Remove or disable your former VGA
subsystem.

Your monitor is not plugged in and
powered on.

Check the cable to the PC and the cable to
the power source, and make sure that the
power switch on the monitor is on.

The VGA /video board is using the
wrong settings.

Confirm the correct settings on the VGA/
video board.

The IRQ or I/O port address setting on
your Live 50 or Live 100 Audio
Communications board conflicts with
another device.

Change your IRQ or I/O port address
setting on the Audio Communications
board. Refer to Appendix B, “Changing
Settings on the PCS 100 Boards.”

PC doesn’t boot up.

There is a conflict with something loaded
by CONFIG.SYS or AUTOEXEC.BAT.

Boot the PC with the F5 or F8 function
keys to isolate the conflicting program
that is being loaded.

You can’t bring up Windows, or the
Windows display is distorted.

You are using the wrong VGA driver.

Change your monitor display setting to
use one of the PictureTel Live VGA
drivers. Refer to “Installing the VGA
Drivers” on page 4-5.

The default video refresh rate is not
supported by your monitor.

Change the video mode setting. Refer to
Appendix G, Changing the Video Mode
Setting.

The wait state is not enabled for your
monitor.

Enable the wait state on the VGA Video
board by sliding the DIP switch labeled
NOWS on switch SW1 to the left (Off)
position.

The IRQ or I/O port address setting on
your Live 50 or Live 100 Audio Comm.
board conflicts with the setting of another
device.

Change your IRQ or I/O port address
setting on the Live 50 or Live 100 Audio
Comm. board by running the PictureTel
Live Setup program

You have an EISA-bus PC and have not
configured the slots in which the Live
boards are installed.

Run the EISA configuration utility. Refer
to “Inserting the Live50 Board” on
page 2-5
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Problem If you encounter a problem starting up PictureTel Live after you've
oblems y p gup y
Starting Up brought up Windows, refer to the instructions in Table 5-2.

PictureTel Live

Table 5-2: Problems Starting Up PictureTel Live

Problem Possible Cause Possible Solution

The following message appears | The interboard ribbon cable Open your PC and check the

in a dialog box when you click is not securely connected to interboard cable connection to
on the PictureTel Live icon: one or both Live 100 boards. | both Live 100 boards.

Unable to initialize PictureTel

Live; Internal

You have a conflict with one | 1. Check these settings.
or more of these settings: 2. Check your PC

Or, the status line at the bottom qg IRQ documentation to determine
of the PictureTel Live main q I/O portaddress available settings; also check
window displays this message: q Upper memory space documentation for settings
PictureTel Live failed — exit allocation used by any other add-on
Windows and restart devices installed in your PC.

3. Run the Microsoft Diagnostics
(MSD) program to check the
current IRQ settings and
memory space allocation.

4. If you change any of these
settings, run the Live
Configuration utility in the
PictureTel Live group.

Or, you have a memory 5. Edit your CONFIG.SYS file to
manager and did not edit exclude the memory space.
your CONFIG.SYS file to The default values are D000-
exclude the memory space D3FE

required by PictureTel Live.

Or, the shadow RAM on 6. Refer to your PC
your PC is not disabled for fiocumgntatlon for
the area of memory that the instructions on how to

PCS 100 uses (default is confirm that shadow RAM

D000-D3EF). has been disabled for the
memory range you are using
for the PCS 100.
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Table 5-2: Problems Starting Up PictureTel Live

Problem

Possible Cause

Possible Solution

You see no video in the Local
Video window when you start
up PictureTel Live.

Your camera is not plugged
in or powered on.

Check the cable to the PC and the
cable to the power source and
check that the power switch on
the camera is on.

The VAFC cable is not
securely connected to the
Live 50 board and the VGA
board. (Live 50 only)

Open your PC and check the
VAFC cable connection to both
boards.

You have specified the
wrong graphics card. (Live
50 only)

Use the Live configure program
and select the correct graphics
card.

The VGA driver that you
have selected may not work
with your monitor.

Select a VGA driver with a
different monitor resolution.

The following message appears:

Network down

The network cable is not
plugged in.

Check the cable connection to the
network.

Either the Live system or the
network is failing.

Choose Diagnostics from the
PictureTel Live Tools menu, and
run the Loopback test. For
instructions, see the PictureTel
Live PCS 50/100 User’s Guide.

If any of this test fails, call your
authorized PictureTel service

provider. If the test passes, call
your network service provider.







Overview

Using Auto
Detect

A

Checking Your
PC Settings

If you start up the PictureTel Live application and see hardware
failure messages, it might mean that one or more default settings
conflict with your PC settings. To search for conflicts, follow the
steps under Checking an ISA-Bus PC orChecking and Configuring an
EISA-Bus PC. If you find a conflict, run the PictureTel Live Setup
program again and change the settings.

If you aren’t sure whether you have an ISA-bus or EISA-bus PC,
refer to the documentation that came with your PC.

The PictureTel Live Setup program can automatically detect
available settings for IRQs, I/O port addresses, and shared memory
space on the Live 50 board and the Live100 Audio Communications
board. However, with some PCs, the Setup program may not be able
to detect one or more of these settings. If this happens, we
recommend you choose the default settings. These settings work for
most PC configurations.

Under Windows 95

On one of the windows of the Setup program there is an “Auto
detect” button that is only active if you are installing PictureTel Live
in a Windows 95 environment. This button causes the Setup
program to review the other devices installed under Windows 95
and selects IRQ, I/O port addresses and shared memory values
which should not conflict with any of these devices.

However, you should be aware that values selected using the Auto
detect feature can still present conflicts under some circumstances.
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hecking an If your PC has an ISA bus, check the current IRQ settings, I/O port

g Yy 8 P

ISA-Bus PC address settings, and shared memory space allocations by following
these steps:

1. Start Windows and select MS-DOS prompt from the Main program
group.
Windows displays an MS-DOS box.
1. From the Windows DOS prompt, type this command:
msd

A warning message may appear; ignore the warning, since in
this case it is beneficial to keep Windows running while you
execute the Microsoft Diagnostics program.

The Microsoft Diagnostics program Main Menu appears.

2. Type q to select IRQ Status.
The IRQ Status screen appears.

3. Locate IRQ 11 and check if it is available.

The Live 50 board and the Live 100 Audio Communications
board use IRQ 11 as its default IRQ setting. If the Description
column displays (Reserved) and if the Detected column is blank,
IRQ 11 is possibly available for the Audio Communications
board.

If a device is using IRQ 11, locate an available IRQ setting and
write it down:

Available IRQ:

You’'ll need to change the setting on the Audio Communications
board, as described in “Changing Settings on the Audio
Communications Board” on page B-3.

4. Press Enter to return to the Diagnostics program Main Menu.

5. Type m to select Memory.

The Memory screen appears.



Checking an ISA-Bus PC

6. Check if the memory address you set in the PictureTel Live Setup
program is available.

If you find that a device is using this shared memory space,
locate an available 16 KB memory range on the Memory screen
and write down its starting address:

Available shared memory space address:

Note: If no 16 KB range in extended memory is available,
you must make it available. If you use the standard
Windows memory manager, this range will be
automatically excluded during installation. If you
use a third-party memory manager, you must add
the appropriate EXCLUDE statement yourself.

7. Press Enter to return to the Diagnostics program Main Menu.
8. Press F3 to exit the Microsoft Diagnostics program.
9. Review your PC documentation for conflicts with the

/O port address you set in the PictureTel Live Setup program.

0 Address 0280 (the default I/O port address for the Audio
Communications board)

0 Address 27CA-27CE (the default I/O port address for the
VGA Video board)

If you have any other add-on boards installed in your PC, also
review the add-on board documentation.



CHECKING YOUR PC SETTINGS

10.

11.

Note: Devices can use 10-bit addresses (up to 03FF), 12-bit
addresses (up to OFFF) or 16-bit address (up to
3FFF). The Livel00 boards use 16-bit addresses, the
Live50 board uses 10-bit addresses.

Boards from other manufacturers which use 10-bit
or 12-bit addresses may accidentally respond to
higher addresses. This is a fairly common problem
due to the continuing evolution of conventions in
the PC hardware industry.

For example, a LAN card which uses the 10-bit
address 0300 might accidentally respond to
commands intended for a different card that uses a
16-bit address such as 1300, since the lower ten bits
of that address are 0300.

Therefore, we recommend that you select a 10-bit
address (below 0400) for the Livel00 Audio
Communications board; however, we recommend
that you do not modify the 16-bit address for your
VGA card (27CA), because the lower 10 bits of that
card are avoided by most 10-bit cards.

If you find that a device is using the selected addresses, locate an
available address and write it down:
Available I/0O port address:

You'll need to change the setting on the appropriate board, as
described in step 11.

Review your PC documentation for additional conflicts.

The Microsoft Diagnostics program does not always report
software IRQ settings or shared memory addresses of devices
that are not currently running.

If you found any conflicts, change the settings by running the
PictureTel Live Setup program again and entering the new
settings.



Checking and Configuring an EISA-Bus PC

Checking and
Configuring an

EISA-Bus PC

If your PC has an EISA bus, use the EISA configuration utility
supplied by the PC manufacturer to do the following:

1. Check your current PC settings for conflicts with the settings for

IRQ, I/O port addresses, and shared memory space you set in the
PictureTel Live Setup program.

If you find any conflicts, locate and write down the available
settings here:

Available IRQ:
Available 1/O port address:

Available shared memory space address:

. If you found any conflicts, change the settings by running the

PictureTel Live Setup program again and entering the new
settings.

. Configure your PC for the Live50 and Live100 Audio

Communications board.

Run your EISA configuration utility to configure your PC for the
Audio Communications board, using these options:

0 Manually configure an ISA board
0 Add a board without a .CFG file
For instructions, refer to your PC documentation.

If you're installing optional PictureTel Live network interface
boards, refer Appendix C or to the documentation provided
with those boards.
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Changing
Settings on the
Live100 Boards

Overview This appendix tells you how to change the IRQ setting and the
1/0 port address settings on the Livel00 boards. If you find conflicts
with any of the default settings on these boards when you check
your PC environment (as explained in Chapter 3), follow the
instructions in this appendix.

Changing To change the I/O port address setting on the VGA Video board,

Settings on the follow these steps:
VGA Video Board 1. Remove the board from its plastic antistatic package.

Caution

A This board can be damaged by static discharge. To equalize
static charge, ground yourself by touching the metal back

panel of your PC.
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Figure B-1 shows the VGA Video board, which you can identify
by the 15-pin VGA connector on the back plate.

T Back plate
B mi " u
HOm0 .l ot VGA
connector

O m 2
Ionl] an

Swi

N ADR2
I IRQ9

CENOWS
OFF |[LJRSVD | ON

Figure B-1: VGA Video Board

2. Place the board on a level surface so that its component side faces
up and the back plate (with the connectors) is to your right.

3. If the default /O port address setting of 27CA—-27CE conflicts with
the I/O port address of another device in your PC, change the
setting for this board to 029A—-029E by doing the following:

a. Refer to Figure B-1 and locate switch SW1 on the board.

b. Use a ballpoint pen to slide the DIP switch labeled ADR2 on
SWI1 to the right. This changes the I/O port address for this
board from 27CA-27CE to 029A-029E.

Caution

Do not use a pencil. The graphite can damage the switch.




Changing Settings on the Audio Communications Board

Changing

Settings on the

Audio

Communications

Board

To change settings on the Audio Communications board, follow
these steps:

1. Remove the board from its plastic antistatic package.

Caution

This board can be damaged by static discharge. To equalize
static charge, ground yourself by touching the metal back
panel of your PC.

Figure B-2 shows the Livel00 Audio Communications board,
which you can identify by the MVIP connector on the top edge.

MVIP connector Back plate

|| |

ll|..- ll- s
l N L .-- m

IRQ setting

f |
[N

12345678
1/0 Address
1011121415 131211109 8 7 6 settings

W962 SW570

Figure B-2: Live100 Audio Communications
Board
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2. Place the board on a level surface so that its component side faces
up and the back plate (with the connectors) is to your right.

3. If the default IRQ setting (IRQ 11) conflicts with the IRQ of another
device in your PC, change the IRQ setting for this board by doing
the following:

a. Refer to Figure B-2 and locate switch SW962 on the board.

This switch has 10 sliding DIP switches. A DIP switch in the
up position is ON and in the down position is OFF.

b. Use a ballpoint pen to slide the DIP switch labeled 7, which
is IRQ 11, down to the OFF position.

Caution

Do not use a pencil. The graphite can damage the switch.

c. Make sure all switches are down in the OFF position before
proceeding to the next step.

d. Slide the DIP switch for your selected IRQ setting up to the
ON position.

Note: Only one DIP switch can be in the ON position.

You'll need to specify this IRQ setting during software
installation, as explained in Chapter 4.



Changing Settings on the Audio Communications Board

4. If the default I/O port address setting (0280) conflicts with the I/O
port address of another device in your PC, change the setting for
this board by doing the following:

a. Refer to Figure B-2 and locate switch SW570 on the Audio
Communications board.

This switch has eight sliding DIP switches. A switch in the
up position is a logical 0, and a switch in the down position
is a logical 1. Figure B-2 illustrates the position of the DIP
switches for the default I/O port setting, which is
hexadecimal 0280.

1/0 port addresses are expressed in hexadecimal and can be
assigned 0000 to 3FCO0 in increments of 64 (40 hexadecimal).

The I/0O port address takes the form
xyz0
where

x is designated with switches 13 and 12 and can be
hexadecimal digits 0, 1, 2, or 3

y is designated with switches 11 through 8 and can be
hexadecimal digits 0 through F

z is designated with switches 7 and 6 can be
hexadecimal digits 0, 4, 8, or C

0 is preset and is not defined by a switch

Table B-1 on the next page provides the switch settings for
each hexadecimal digit. The leftmost column lists the 16
hexadecimal digits. The remaining columns show you how
to set each switch for that digit.
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Table B-1: Switch Settings for Hexadecimal Digits

Switch Number

x Position y Position z Position
Digit 13 12 11 9 7 6
o | 0 0 I

1
2
3
4
5
6
7
8
9
A
B
C
D
E
F

I
I
I

| Cw W ECE e | CmC.

| smly ssull ssnil sssil ssaly Ssnil il seslpees fhees RRees hees Bpees Bl e NN

l:ll:ll:ll:ll:ll:ll:ll:ll:ll:ll:ll:ll:ll:ll:ll:ls

[

I
l
I
l
I
l
I
l
I
l
I
l
I
l
I
l

Note: The shading indicates that the digit is not allowed in this

position.
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b. Use a ballpoint pen to slide the following DIP switches:

For the digit in position x, set switches 13 and 12
accordingly. This digit can be 0, 1, 2, or 3 only.

For the digit in position y, set switches 11 through 8
accordingly. This digit can be 0 through F.

For the digit in position z, set switches 7 and 6
accordingly. This digit can be 0, 4, 8, or C only.

Remember, the last 0 in the address is preset; you do not
have to set any switches.

Caution

Do not use a pencil. The graphite can damage the switches.

For example, to set the address to 0200, set the switches like
this:

Logical 0

R ithihihish

Logical 1

13121110 9 8 7 6
0 2 0 0

Or, to set the address to 16C0, set the switches like this:

Logical O

L el

Logical 1

13121110 9 8 7 6
1 6 C 0

You’ll need to specify the new I/O port address setting
during software installation, as explained in Chapter 4.
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C

Installing
Network Interface
Boards

This appendix contains installation instructions for the available
Network Interfaces for the Live50 and Livel00 videoconferencing
systems. It also includes information on cable connections to the
Inverse Multiplexer (IMUX) devices, which provide a variety of
network solutions for videoconferencing applications.

The installation procedures differ slightly, depending on whether
you are installing the Switched-56 or the V.35/RS-449 Data-Dialer
Module/Network Interface board. The procedures for each type of
installation are summarized below:

To install the Switched-56 Network Interface board:

1. Install the Live50/Live100 hardware using Chapter 2, Installing
PictureTel Live50 Hardware or Chapter 3, Installing PictureTel
Live100 Hardware for instructions.

2. Install the Switched-56 Network Interface board.

3. Install the PictureTel Live application software using Chapter 4,
Installing PictureTel Live Software, for instructions.

To install the V.35/RS-449 Data-Dialer Module (DDM)/Network
Interface board:

1. Install the Live50/Live100 hardware using Chapter 2, Installing
PictureTel Live50 Hardware or Chapter 3, Installing PictureTel
Live100 Hardware for instructions.

2. Install the DDM/Network Interface board.
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3. Install the PictureTel Live application software using Chapter 4,
Installing PictureTel Live Software, for instructions.

Note: On the Network Interface Settings window, be sure
to select ISDN BRI only (and no additional
networks) to test your Live50/Livel00 installation.

If donot have ISDN service, you should still perform
this step, selecting “AT&T 5ESS custom point-to-
point” as the ISDN protocol.

4. When the installation is complete, select Tools > Diagnostics >
Loopback to test the audio and video and verify the Live50/Live100
installation integrity.

5. Install the DDM/Network Interface board software as described
later in this document.

6. When the installation is complete, select Tools > Diagnostics >
Loopback to test the integrity of your DDM/Network Interface
board installation.



Qverview

In this Appendix

This appendix covers the following major topics:

Topic Page
Connection Types 5
Installing the Switched-56 Network Interface 6
Board
Installing the Data-Dialer Module/Network 15
Interface Board
Installing the Data-Dialer Module/Network 27
Interface Board Software
Cable Pinouts 40
Maximum Cable Length 45
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Before You Begin

Switched-56 Kit

Make sure your product kit contains all of the appropriate items
(listed below).

Interface Installation Guide

Component Quantity N:;Lter
Switched-56 Network Interface board 1
Live50 CHI to MVIP cable (1) 1 180-0293-01
Livel00 MVIP cable (1) 1 510-0167-01
Switched-56 chassis label (1) 1
Loopback test cables (2) 2
Switched-56 network cables 2
PictureTel Live50/Livel00 Network 1 800-0610-02
Interface Installation Guide

DDM V.35 Kit

Component Quantity N:r:':er
DDM /Network Interface board 1
Live50 CHI to MVIP cable 1 180-0293-01
Live100 MVIP cable 1 510-0167-01
V.35/RS-366 4-leg cable 1 180-0313-01
DDM /Network Interface board 2
installation diskettes
PictureTel Live50/Livel00 Network 1 800-0610-02




Connection Types

DDM RS-449 Kit

. Part
Component Quantity Number

DDM /Network Interface board 1
Live50 CHI to MVIP cable 1 180-0293-01
Live100 MVIP cable 1 510-0167-01
RS-449 /RS-366 4-leg cable 1 180-0312-01
DDM /Network Interface board 2
installation diskettes
PictureTel Live50/Livel00 Network 1 800-0610-02
Interface Installation Guide

nn ion The following table identifies the appropriate Network Interface

onnectio g pprop
Types board for each type of network connection.

If you need this connection
type:

You need this type of board:

Integrated 4-Wire SW56 Switched-56 Network Interface

nondialed

V.35 (or RS-449) dialed/ DDM /Network Interface

Note: For V.35/RS-449 connections, CSU/DSUs (Channel
Service Unit/Data Service Units) may be required
between the PC and the telephone company’s digital
network connection. Your installation may already have
these devices in place. Consult your telephone company

representative.
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Installing the
Switched-56
Network Interface
Board

C-6

The Switched-56 Network Interface board allows you to connect
your PictureTel® Live™ videoconferencing system to a digital data
network using a Switched-56 interface.

These components are included with your Network Interface board:

Component Quantity N;:r;er

Switched-56 Network Interface board 1

Live50 CHI to MVIP cable (1) 1 180-0293-01
Live100 MVIP cable (1) 1 510-0167-01
Switched-56 chassis label (1) 1

Loopback test cables (2) 2

Switched-56 network cables 2

PictureTel Live50/Livel00 Network 1 800-0610-02
Interface Installation Guide

Your Switched-56 Network Interface board uses 01C0 (hexadecimal)
as its default I/O port address, which is set using a DIP switch. It
also uses IRQ 15 as its default IRQ setting, which is set using a
jumper. The next section explains how to change these settings if
necessary.

Caution

Before you install the Network Interface board, you should
check and configure the environment on your ISA-bus or
EISA-bus PC. Refer to Appendix A, Checking Your PC Settings
for instructions.




Installing the Switched-56 Network Interface Board

Unpacking the Switched-56 Network Interface Board
To unpack the Switched-56 Network Interface board:

1. Remove the board from the plastic antistatic package.

Caution

static charge, ground yourself by touching the metal back

i'i This board can be damaged by static discharge. To equalize
panel of your PC.

2. Place the board on a level surface so that its component side faces
up and the back plate (with the connectors) is to your right.

Changing the IRQ Setting on the Switched-56 Network
Interface Board

Note: If the default IRQ setting (IRQ 15) does not conflict with
the IRQ setting of another device in your PC, you can

skip this section.

To change the board’s IRQ setting, follow these steps:

1. Find the jumper block on the board.

The jumper block is just above the edge connector at the bottom
of the board. It has 12 pairs of unlabeled pins, with a jumper
bridging one of the pairs. Each jumper position represents a
different IRQ setting, as shown here:

Jumper
—- F - -]
[ ]
Board Orientation: 1514121110 9 7 6 5 4 3 < IRQ Setting
Backplate on the right
ISA gold fingers down (Unused)

2. Choose a setting other than 15 and identify the pair of pins that
matches your chosen setting.
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3. Move the jumper to the new position.

Remove the jumper shunt from the jumper block by lifting it
straight up. Then align it over the correct pair of pins, and push
it straight down.

Record your IRQ setting. You must specify it during software
installation.

Changing the I/0 Port Address on the Switched-56 Network
Interface Board

Note: If the default I/O port address setting (01C0) does not
conflict with the I/O port address of another device in
your PC, you can skip this section.

The board’s I/O port address is set with a switch located at the top
center of the board. The switch has six sliding DIP switches. A
switch in the up position is a logical 0 (off), and a switch in the down
position is a logical 1 (on).

The illustration below shows the switch positions for the default
1/0 port address setting, which is hexadecimal 01CO:

D D U U U D Logical 0
. Lt s 0 L Logical 1
01Co= 0 C 1 0
Left - Right

C-8



Installing the Switched-56 Network Interface Board

The I/O port address takes the form:
Oxy0
where:
0 is preset and is not defined by a switch.

x is designated with switches 5 and 6 and can be digits 0, 1, 2,
or 3.

y is designated with switches 1 through 4 and can be digits 0
through F.

0 is preset and is not defined by a switch.

I/0O port addresses are expressed in hexadecimal and can be
assigned a value from 0000 to 03F0 in increments of 16
(10 hexadecimal).

Note: These switch settings do not follow the same scheme as
the settings on the Livel00 Audio Communications
board.

To set the I/O port address on your Switched-56 Network Interface
board:

1. Make sure that the back plate (with the connectors) is facing
toward your right.

2. For the digit in position x, set switches 5 and 6 accordingly.

Use a thin, blunt instrument, such as a ballpoint pen.

é Caution

Do not use a pencil; the graphite can damage the switches.
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This digit canbe a 0, 1, 2, or 3 only.

D D D D |:| H Logical 0
L s s 0 L Logical 1
0 y X 0
Left - Right

Digit Values | Switch 5 | Switch 6

0 I I

1

I I
2 I l
l l
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3. For the digit in position y, set switches 1 through 4 accordingly.
This digit can be 0 through F.

1 2 3

4 5 6

AR

0 y
Left -

Logical 0

|

Logical 1

0

Right

Digit Values | Switch 1

Switch 2

Switch 3

Switch 4

o
[— |

[— |

[— |

[— |

CEAaEECOCEEEOOC ] Cma O CE O m

O CEC RO C e Ca ) C e .

OO O CECECEC A ) CmC .

oo
|

|

|

OO OO OO CECeaCmC mCmCEmC=.

The leftmost and rightmost Os in the address are preset; you do not

have to set any switches.
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For example, to set the address to 0240, set the switches like this:

D D u D D u Logical 0
t 2 3 4 5 ¢ Logical 1
0 4 2 0
Left - Right

Or, to set the address to 03A0, set the switches like this:

D u D u u u Logical 0
L2 2 * 0 ° Logical 1
0 A 3 0
Left - Right

Record your I/O port address. You must specify it during software
installation.

Inserting the Switched-56 Network Interface Board into the PC
To install the Switched-56 Network Interface board into the PC:

Caution

A Turn off the computer and all peripheral devices before

performing the following procedures.

1. Select an expansion slot that is no more than one slot away from
the Live100 Audio Communications board, or the Live50 board.

2. Remove the filler plate on the expansion slot you have selected for
this board and save the screw.

3. Insert the board into an available ISA expansion slot.
4. Make sure the board is securely seated into the PC.

5. Secure it with the screw that held the filler plate.
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Connecting the Switched-56 Network Interface Board

AN

The Network Interface board needs to be connected to either the
Live100 Audio Communications board or the Live50 board using
the supplied MVIP cable. The MVIP cable for the Livel00 product
can be identified by the 40-pin connectors on each end. The CHI to
MVIP cable for the Live50 product uses a 40-pin connector for
attaching the Network Interface card and an 8-pin Molex connector
for attaching to the Live50 board.

Live100 MVIP Cable
(Part #510-0167-01)

=]

Live50 CHI to MVIP Cable
(Part #180-0293-01)

Connecting the Live100 MVIP Cable

For the Live100 product, connect the Switched-56 Network Interface
board to the Audio Communications board by using the supplied
ribbon cable with a 40-pin connector on each end.

Caution

Use care when connecting the MVIP cable to the board so as
not to damage the pins.
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AN\
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To connect the two boards using the MVIP cable, follow these steps:

1.
2.

Grasp the connector on one end of the ribbon cable.

Line up the key on this connector with the slot on the expansion
connector attached to the front of the Live100 Audio
Communications board.

. Slide the key into the expansion connector slot.

. Repeat these steps to connect the other end of the ribbon cable to

the Network Interface board.

Connecting the Live50 CHI to MVIP Cable

For the Live50 product, connect the Switched-56 Network Interface
board to the Live50 board by using the supplied CHI to MVIP cable
with a 40-pin connector on one end and an 8-pin connector on the
opposite end.

Caution

Use care when connecting the CHI to MVIP cable to the
board so as not to damage the pins.

To connect the two boards using the CHI to MVIP cable, follow these
steps:

1.
2.

Grasp the 40-pin connector on one end of the cable.

Line up the key on this connector with the slot on the expansion
connector attached to the Network Interface board.

. Slide the key into the expansion connector slot.

. Connect the 8-pin connector to the Live50 board.

Note: Be sure to position the 8-pin connector so that the
white wire is closest to the back plate on the
Network Interface board.

Now you need to install the Live50 or Livel00 application software,
as instructed in Chapter 4, Installing PictureTel Live Software.



Installing the DDM/Network Interface Board

Installing the
DDM/Network
Interface Board

The DDM/Network Interface board allows you to connect your
PictureTel Live videoconferencing system to a high-speed data
network using a V.35 or an RS-449 interface.

These components are included with your Network Interface board:

DDM V.35 Kit
Component Quantity N:;Lter

DDM /Network Interface board 1

Live50 CHI to MVIP cable 1 180-0293-01
Livel00 MVIP cable 1 510-0167-01
V.35/RS-366 4-leg cable 1 180-0313-01
DDM /Network Interface board 2

installation diskettes

PictureTel Live50/Livel00 Network 1 800-0610-02

Interface Installation Guide
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DDM RS-449 Kit

Component Quantity Nl:::::er
DDM /Network Interface board 1
Live50 CHI to MVIP cable 1 180-0293-01
Livel00 MVIP cable 1 510-0167-01
RS-449 /RS-366 4-leg cable 1 180-0312-01
DDM /Network Interface board 2
installation diskettes
PictureTel Live50/Livel00 Network 1 800-0610-02
Interface Installation Guide

The V.35/RS-449 Network Interface boards use 3CCO (hexadecimal)
as the defaultI/O port address, which is set using a DIP switch. For
more information, refer to Changing the I/O Port Address on the DDM/
Network Interface Board (below).

Caution

Before you install the Network Interface board, you should

check and configure the environment on your ISA-bus or
EISA-bus PC. Refer to Appendix A, Checking Your PC Settings

for instructions on these procedures.

Unpacking the DDM/Network Interface Board

To unpack the DDM/Network Interface board, remove the board
from its protective box and then from the plastic antistatic package.
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Caution

This board can be damaged by static discharge. To equalize
static charge, ground yourself by touching the metal back
panel of your PC.

Place the board on a level surface so that the component side faces
up and the back plate (with the connectors) is to your right, as
shown in the following illustration.

MVIP Connector
( DDM DIP Switch

DDM/Network Interface Board
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Changing the I/0 Port Address on the DDM/Network Interface

Note: If the default I/O port address setting (3CCO0) does not
conflict with the I/O port address of another device in
your PC, you can skip this section.

The board’s I/O port address is set with a switch located at the top
right of the board (near the back plate). The switch has eight sliding
DIP switches. A switch in the up position is a logical 0 (off), and a
switch in the down position is a logical 1 (on).

The I/O port address takes the form:
xyz0
where:

x is designated with switches 7 and 8 and can be digits 0, 1, 2,
or 3.

y is designated with switches 3 through 6 and can be digits 0
through F.

zis designated with switches 1 and 2 and can be digits 00, 40, 80,
or C0.

0 (the last digit) is constant and has no associated switches.

I/0O port addresses are expressed in hexadecimal and can be
assigned a value from 0000 to 3FCO in increments of 16
(10 hexadecimal).

The default I/O port address setting (3CCO0) is illustrated below:

uﬂnnuuuu T
1 2 3 4 5 6 7 8
Logical 1
0 z y X
Left - Right




Installing the DDM/Network Interface Board

To change the I/O port address on your DDM /Network Interface
board:

1. Make sure that the back plate (with the connectors) is facing
toward your right.

2. For the digit in position x, set switches 7 and 8 accordingly.

Use a thin, blunt instrument, such as a ballpoint pen.

Caution

Do not use a pencil; the graphite can damage the switches.

This digit canbe a 0, 1, 2, or 3 only.

jjoooomn Y
1 2 3 4 5 6 7 8 I
Logical 1
0 z y X
Left - Right

Digit Values | Switch 7 | Switch 8

0 I I

1

! I
2 I I
! !
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rdingly.

3. For the digit in position y, set switches 3 through 6 acco

This digit can be 0 through F.

Logical 0

Logical 1

JURERRUY

z
Left =g

Digit Values

Right

Switch 3 | Switch 4 | Switch 5 | Switch 6
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4. For the digit in position z, set switches 1 and 2 accordingly.
Use a thin, blunt instrument, such as a ballpoint pen.
This digit can be a 00, 40, 80, or CO only.

ooy 7
1 2 3 4 5 6 7 8 Loglcal 1

0 z y X

Left g Right

Digit Values | Switch 1 | Switch 2

00 i i
10 J f
80 i J
o J J

Note: Be sure to record your I/O port address. You must
specify it during software installation.
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Examples of I/O port address settings are provided below:

Left-g Right
0100
U D H ﬂ U U D H T
1 2 3 4 5 6 7 8 Logi?:al 1
0 z y X
1240
u D D ﬂ U U u U n
i+ 2 3 4 5 6 7 8 Logical 1
0 z y X
2480
U u D U H U D u T
1 2 3 4 5 6 7 8 Logi?:al 1
0 z y X
37C0
ﬂ ﬂ H U ﬂ ﬂ H |1 T
12 3 4 5 6 7 8 Logi?:al 1
0 z y X




Installing the DDM/Network Interface Board

Left-g Right
0940
ﬂ D H U U H D U T
i1 2 3 4 5 6 7 8 Logi{aH
0 z y X
2A80
D u D ﬂ U H D u T
1 2 3 4 5 6 7 8 Logical 1
0 z y X
3DCo
ﬂ u u U H u u u T
1 2 3 4 5 6 7 8 Logi{aH
0 z y X
2F00
ﬂ U u U u ﬂ D |1 T
1 2 3 4 5 6 7 8 Logical 1
0 z y X
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Inserting the DDM/Network Interface Board into the PC
To install the DDM /Network Interface board into the PC:

Caution

A Turn off the computer and all peripheral devices before

performing the following procedures.

1. Select an expansion slot that is no more than one slot away from
the Live100 Audio Communications board, or the Live50 board.

2. Remove the filler plate on the expansion slot you have selected for
this board and save the screw.

3. Insert the board into an available ISA expansion slot.
4. Make sure the board is securely seated into the PC.

5. Secure it with the screw that held the filler plate.

Connecting the DDM/Network Interface Board

The DDM /Network Interface board needs to be connected to either
the Livel00 Audio Communications board or the Live50 board
using the supplied MVIP cable. The MVIP cable for the Live100
product can be identified by the 40-pin connectors on each end. The
CHI to MVIP cable for the Live50 product uses a 40-pin connector
for attaching to the Network Interface card and an 8-pin Molex
connector for attaching to the Live50 board.
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Live100 MVIP Cable
(Part #510-0167-01)

=]

Live50 CHI to MVIP Cable
(Part # 180-0293-01)

Connecting the Live100 MVIP Cable

For the Livel00 product, connect the DDM/Network Interface
board to the Audio Communications board by using the supplied
ribbon cable with a 40-pin connector on each end.

Caution

Use care when connecting the MVIP cable to the board so as
not to damage the pins.

To connect the two boards using the MVIP cable, follow these steps:
1. Grasp the connector on one end of the ribbon cable.

2. Line up the key on this connector with the slot on the expansion
connector attached to the front of the Live100 Audio
Communications board.

3. Slide the key into the expansion connector s Repeat these steps
to connect the other end of the ribbon cable to the Network
Interface board.
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Connecting the Live50 CHI to MVIP Cable

For the Live50 product, connect the DDM/Network Interface board
to the Live50 board by using the supplied CHI to MVIP cable with a
40-pin connector on one end and an 8-pin Molex connector on the
other end.

Caution

Use care when connecting the CHI to MVIP cable to the
board so as not to damage the pins.

To connect the two boards using the CHI to MVIP cable, follow these
steps:

1. Grasp the 40-pin connector on one end of the cable.

2. Line up the key on this connector with the slot on the expansion
connector attached to the Network Interface board.

3. Slide the key into the expansion connector slot.

4. Connect the 8-pin connector to the Live50 board.
Note: Be sure to position the 8-pin connector so that the

white wire is closest to the back plate on the
Network Interface board.

Now you need to install the Data-Dialer Module/Network Interface
Board software.



Installing the Data-Dialer Module/Network Interface Board Software

Instal |ing the To install the software for the Data-Dialer Module /Network
Data-Dialer Interface Board, perform the following procedures:

Module/Network 1.

Interface Board
Software

Install the Live50/Live100 application software, as instructed in
Chapter 4, Installing PictureTel Live Software.

Note: If you have already installed the Live50/Livel00
application software, verify that your Live50/
Livel00 hardware is working properly. For
instructions, refer toVerifying Your Installation in
Chapter 4.

Insert the DDM/Network Interface Board
Installation Software Disk 1 of 2 into drive A: or B:.

. Fromthe Windows 3.1x Program Manager, Select File...Run. From

the Windows 95 Start Menu, select Run... Program.

. Type A:SETUP or B:SETUP. Press Enter, and follow the on-screen

instructions to install your software.

. When the software installation is complete, select PictureTel

Live50/Live100 Configure from the PictureTel Program Manager
group.

. The Registration Confirmation window is displayed.

Click Continue.
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6. .The Network Interface Settings window is displayed.

If the V.35/RS-449 will be your only Network Interface, toggle
off the ISDN BRI check box, and select the appropriate Network
Interface type, as shown below.

= Metwork Interface Settings

Please select the type of network
é interface(s] to be used for videoconferencing
= at your PC. Network interfaces other than
ISDN BRI require additional boards.

mfi

Additional Network Interfaces:

3 None

) Switched 56

® ¥ 35/R5-449 dialed

) ¥_35/RS5-449 non-dialed [dedicated

I_Qonlinue || Back ” Exit Il Help I

When you have selected the appropriate Network Interface
settings, click Continue.

7. The Hardware Settings window is displayed.

In the Hardware Type field, select Integrated data-dialer
module. Then click Continue.
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8. The DDM Base I/O Address and DDM IRQ fields appear on the
Hardware Settings window.

= ¥.35 Hardware Settings

Please select the type of
V.35/R5-443/R5-366 hardware which is
= installed. and enler the comesponding

Hardware Tupe
’V Separate data and dialer cards

@ Integrated data-dialer module

DDM Base 1/0 Address
( |3 [=][c] [2l[c] @] © - osscco

DDM IRQ
Quntinuel ‘ Back I | Exit I ‘ Help I

This window illustrates the default DDM base I/O address
setting. If your DDM base 1/O address setting differs from the
default, the correct setting is detected and displayed.

If no changes are required, click Continue.

9. The Node Name Selection window is displayed.
If no changes are required, click Continue.
10. The Modify CONFIG.SYS file window is displayed.

If no changes are required, click No Change.

11. The Installation Complete window in displayed.

Click OK to reboot and restart your system.

12. Start the Live50/Live100 application, and select Tools >
Preferences.
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13. The Preferences window is displayed.

Select Network from the Category scroll bar, and select V.35/RS-
449, in the Network field.

Category: | oK I
Metwork: |y 35/RS-449 +

Cancel I

Default Channel Rate: tI

Dial Time Out: seconds

Information Sharing
[ Enabled

When you have made the appropriate selections on the
Preferences window, click OK.

14. To verify the integrity of your installation, choose Tools >
Diagnostics > Loopback.

Note: To make the Diagnostics window active during
Loopback testing, press Alt-Tab.
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15. From the Diagnostics window, choose View > Current Call
Information.

File View Test

| Loopback I EndTest I | 0K I

Current Call Information

¥.35/R5-449 64K

Both channels connected
Transmitting: Full CIF
Receiving: Full CIF

PT 724

MNoise Suppression enabled
Auto Gain Control enabled
Data Receive Rate: 9600
Data Transmit Rate: 9600

On the Current Call Information screen, verify that:

® The correct network type has been selected. For example, if

you selected V.35/RS-449, it should be displayed on the first
line.

¢ Both channels are connected.

e The Data Receive and Data Transmit rates are the same.

16. When you have verified the integrity of your installation, click End
Test to finish the Loopback testl
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IMUX Cabling IMUXs are a family of devices that provide switched digital access

Configurations for PictureTel videoconferencing and multipoint bridge products.
The following information presents cabling information for
connecting the Live50 and Livel00 products, with V.35/RS-449
Network Interface boards, to many of the IMUX products in use
today.

Figure 1 represents the connection of an RS5-449 /RS-366-equipped
PictureTel Live50/Livel00 system with an IMX-1BN, IMX-1BA, or
IMX-1BE.

D37M

RS-449 Data Cables —D
{l
(]

RS-366 Dialing Cables I | D
80-pin 180-0312-01 D25M D25F D26M
ECSI M IMX1B to RS-366 adapter cable
onnector L
SYSTEM 180-0101-01 IMUX

Figure 1. Connecting an RS-449/RS-366-equipped Live
system with an IMX-1BN, -1BA, or -1BE

If operation at data rates above 128 Kbps (up to and including 384
Kbps) is required, then the option 384-UPG is also required.
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Figure 2 represents the connection of an RS-449 /RS-366-equipped

Live50/Livel00 system with an IMX-1 (or Promptus Oasis 200T-RS-
449)

D37M
RS-449 Data Cables Jl:l
RS-366 Dialing Cables ﬂ
80-pin 180-0312-01 D25M
SCSIM
Connector
SYSTEM

IMUX

Figure 2. Connecting an RS-449/RS-366-equipped Live

system with an IMX-1 or Promptus Oasis 200T-RS-
449

If operation at data rates above 128 Kbps (up to and including 384
Kbps) is required, then the option 384-UPG is also required.
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Figure 3 represents the connection of a V.35/RS-366-equipped
Live50/Livel00 system with a Teleos Model 20 Videohub.

M34M MB34F 220-0089-0004 D25M

V.35 Data Cables Jl:l D D
= [ {

RS-366 Dialing Cables _D |:|I D
—] [ ]

80-pin 180-0313-01 D25M D25F  220-0093-0004 D15SM
80-pin 0-0093-000

Connector ||
SYSTEM IMUX

Figure 3. Connecting a V.35/RS-366-equipped Live system to
a Teleos Model 20 Videohub

If operation at data rates above 128 Kbps (up to and including 384
Kbps) is required, then the option 384-UPG is also required.
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Figure 4 represents the connecting of an Ascend Multiband Plus or
VSX using PictureTel cables.

D25F
D37M MBHD-449-366
RS-449 Data Cables :l
:l DSVE D44M Ascend
RS-366 Dialing Cables DI5F VSX/MB+
:l MBHD-449-366
80-pin 180-0312-01
SCSIM D25M D3E D&M
Connector
SYSTEM
M25F
D34M "
V.35 Data Cables MBHD-V35-366
:l MB34F D44M Ascend
RS-366 Dialing Cables Jl:l DoSF VSX/MB+
ﬂ MBHD-V35-366
80-pin 180-0313-01 H>D
SCSIM D25M iy
Connector MB34F
SYSTEM

Figure 4. Connecting an RS-449/RS-366-equipped Live
system with an Ascend Multiband Plus or VSX
using PictureTel cables

If operation at data rates above 128 Kbps (up to and including 384
Kbps) is required, then the option 384-UPG is also required.

C-35



INSTALLING NETWORK INTERFACE BOARDS

Figure 5 represents the connection of an ASCEND MAX with a
Live50 or Livel00 that uses the V.35/RS-449 Interface for data and

the RS-366 for dialing.
D25F RS-449
MBHD-449-366
D37M D44F
RS-449 Data Cables -
DA4M SCSI-80
RS-366 Dialing Cables D25F
:| MBHD-449-366 D44F MAX
g(():-gllrﬁ/[ 180-0312-01 D25M
D44M
Connector DAE
SYSTEM
V.35
D25F
M34M MBHD-V35-366
V.35 Data Cables ! | D44F
ﬂ DaaM SCSI-80
RS-366 Dialing Cables [1 ~ M34F Da4F
D25F MAX
SCSIM
Connector
D44M
SYSTEM MB34F

Figure 5. Connecting an RS-449/RS-366-equipped Live
system with an Ascend MAX

If operation at data rates above 128 Kbps (up to and including 384
Kbps) is required, then the option 384-UPG is also required.

Note: A better cable solution for the above system is shown in
Figure 6.
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Figure 6 represents the connection of a V.35/RS-449 & RS-366-
equipped Live50 or Livel(00 to an Ascend MAX using an Ascend
MBHD-PT1000 Cable.

D37F
Ascend MBHD-PT1000
D44M

DZSFVBS /RS-449 Data DA4F

I | MBVHD-3MBHD
RS-366 Dialing Cables :l

D37M
RS-449 Data Cables l |

Ascend2510-0113-001

SCSI-80
80-pin 180-0312-01  Da5M D37F
SCorM ‘Ascend MBHD-449-366
SYSTEM |
MAX

RS-366 Dialing DaM
D25F
Figure 6. Connecting an RS-449/RS-366-equipped Live
system with an Ascend MAX using an Ascend
MBHD-PT1000 cable

If operation at data rates above 128 Kbps (up to and including 384
Kbps) is required, then the option 384-UPG is also required.
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Figure 7 represents the connection of an ADTRAN ISU 2X64 (both
the S/T- and U-interface models) with a V.35/RS-366-equipped

Live50 or Livel00.
M34M M34F RS-530 10 V.35 ad D25M
V.35 Data Cables ! | D -530 to V.35 adapter D
Il:l MI;LF Adtran 1200072L1 D
RS-366 Dialing Cables I |
D25F D25M
ﬂ I:II Standard RS-366 cable D
80-pin 180-0313-01 D25M
SCSIM ]
Connector D25F D25M

SYSTEM ISU

Figure 7. Connecting an RS-449/RS-366-equipped Live
system with an ADTRAN ISU 2X64 (S/T and U
interface models)
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Figure 8 represents the connection of an ADTRAN ISU 512 IMUX
with a V.35/RS-366-equipped Live50 or Live100.

M34M direct connect
V.35 Data Cables I

—{] M3 Rs-530 to V35 adapter 1
Adtran 1200072L1

RS366 Dialing Cables ! |

80-pin  180-0313-01 D25M Adtran RS-366 “Y”
SCSIM D25F
Connector

1200120L1 b2sM [ |
SYSTEM IMUX
ISU 512

Figure 8. Connecting an RS-449/RS-366-equipped Live
system with an ADTRAN ISU 512 IMUX
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Cable Pinouts

The following tables list the pinouts for the PictureTel Live50/

Livel00 cables. Note that the pins are arranged by wire pairs.

PINOUTS FOR Live50/100 RS-449/RS-366 4-Leg DDM
CABLE (#180-0312-01)

RS-449 Port A RS-449 Port B
P1 Signal P2 Signal P1 Signal P4 Signal

1 FGND |1 FGND 21 FGND |1 FGND
41 SGND |19* |SGND 61 SGND |19* |SGND
2 SD(a) |4 SD(a) 22 SD(a) |4 SD(a)
42 SD(b) |22 SD(b) 62 SD(b) |22 SD(b)
3 ST@) |5 ST(a) 23 ST(@) |5 ST(a)
43 ST(b) |23 ST(b) 63 ST(b) |23 ST(b)
4 RD(a) |6 RD(a) 24 RD(a) |6 RD(a)
44 RD(b) |24 RD(b) 64 RD(b) |24 RD(b)
5 RT(@) |8 RT(a) 25 RT(a) |8 RT(a)
45 RT(b) |26 RT(b) 65 RT(b) |26 RT(b)
6 TT(a) |17 TT(a) 26 TT(a) |17 TT(a)
46 TT() |35 TT(b) 66 TT() |35 TT(b)
7 RS(a) |7* RS(a) 27 RS(a) |7* RS(a)
47 RS(b) |25* | RS(b) 67 RS(b) |25* |RS(b)
8 CTS(a) |9 CS(a) 28 CTS(a) |9 CS(a)
48 CTS(b) |27 CS(b) 68 CTS(b) |27 CS(b)
9 DTR(a) |12 TR(a) 29 DTR(a) |12 TR(a)
49 DTR(b) |30 TR(b) 69 DTR(b) |30 TR(b)
10 RR(a) |13 RR(a) 30 RR(a) |13 RR(a)
50 RR(b) |31 RR(b) 70 RR(b) |31 RR(b)
11 DSR(a) |11 DM(a) 31 DSR(a) |11 DM(a)
51 DSR(b) |29 DM(b) 71 DSR(b) |29 DM(b)
12 RI 15 IC 32 RI 15 IC
53 RC 20 RC 73 RC 20 RC

21*  |LOS(b) 21*  |LOS(b)

3* LOS(a) 3* LOS(a)

37 |SC 37 |SC

C-40
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Cable Pinouts

PINOUTS FOR Live50/100 RS-449/RS-366 4-Leg DDM

CABLE (#180-0312-01) (continued)

RS-366 Port A

RS-366 Port B

P1 Signal P3 Signal P1 Signal P5 Signal
54 SGND |7 SGND 74 SGND |7 SGND
13 FGND |1 FGND 33 FGND |1 FGND
14 NB1 14 NB1 34 NB1 14 NB1
15 NB2 15 NB2 35 NB2 15 NB2
16 NB4 16 NB4 36 NB4 16 NB4
17 NB8 17 NBS8 37 NB8 17 NB8
55 DPR 2 DPR 75 DPR 2 DPR
56 ACR 3 ACR 76 ACR 3 ACR
57 CRQ 4 CRQ 77 CRQ 4 CRQ
58 PND |5 PND 78 PND |5 PND
18 RC 18 RC 38 RC 18 RC
19 SC 19 SC 39 SC 19 SC
59 PWI 6 PWI 79 PWI 6 PWI
60 DSC 13 DSC 80 DSC 13 DSC
20 DLO 22 DLO 40 DLO 22 DLO
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Figure 9 represents the Live50/Livel00 DDM cable (#180-0312-01).

P5

Figure 9. RS-449/RS-366 4-Leg DDM Cable (#180-0312-01)
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PINOUTS FOR Live50/100 V.35/RS-366 4-Leg DDM CABLE
(#180-0313-01)

V.35 Data Port A V.35 Data Port B

P1 Signal P2 Signal P1 Signal P4 Signal
1 FGND |A FGND 21 FGND |A FGND
41 SGND |B SGND 61 SGND |B SGND
2 SD(a) |P SD(a) 22 SD(a) |P SD(a)
42 SD() |S SD(b) 62 SD(b) |S SD(b)
3 ST(@) |Y SCT(a) 23 ST(@) |Y SCT(a)
43 ST(b) |AA |SCT(b) 63 ST(b) |AA |SCT(b)
4 RD(a) |R RD(a) 24 RD(a) |R RD(a)
44 RD(b) |T RD(b) 64 RD(b) |T RD(b)
5 RT@) |V SCR(a) 25 RT(@) |V SCR(a)
45 RT(b) |X SCR(b) 65 RT(b) |X SCR(b)
6 TT@) |U SCTE(a) 26 TT@) |U SCTE(a)
46 TT() |W SCTE(b) 66 TT() |W SCTE(b)
7 RS C RTS 27 RS C RTS
8 CTs D CTs 28 CTs D CTs
48 CTs B SGND 68 CTS B SGND
9 DTR H DTR 29 DTR H DTR
10 RR F RLSD 30 RR F RLSD
50 RR B SGND 70 RR B SGND
11 DSR E DSR 31 DSR E DSR
51 DSR B SGND 71 DSR B SGND
12 RI ] RI 32 RI ] RI
53 RC B SGND 73 RC B SGND
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PINOUTS FOR Live50/100 V.35/RS-366 4-Leg DDM CABLE
(#180-0313-01) (continued)

RS-366 Dialer Port A RS-366 Dialer Port B
P1 Signal P3 Signal P1 Signal P5 Signal
54 SGND |7 SGND 74 SGND |7 SGND
13 FGND |1 FGND 33 FGND |1 FGND
14 NB1 14 NB1 34 NB1 14 NB1
15 NB2 15 NB2 35 NB2 15 NB2
16 NB4 16 NB4 36 NB4 16 NB4
17 NB8 17 NBS8 37 NB8 17 NBS8
55 DPR 2 DPR 75 DPR 2 DPR
56 ACR 3 ACR 76 ACR 3 ACR
57 CRQ 4 CRQ 77 CRQ 4 CRQ
58 PND 5 PND 78 PND 5 PND
18 RC 18 RC 38 RC 18 RC
19 SC 19 SC 39 SC 19 SC
59 PWI 6 PWI 79 PWI 6 PWI
60 DSC 13 DSC 80 DSC 13 DSC
20 DLO 22 DLO 40 DLO 22 DLO
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Maximum Cable Length

Maximum Cable
Length

Figure 10 represents the Live50/Live100 DDM cable (#180-0313-01).

Figure 10. V.35/RS-366 4-Leg DDM Cable (#180-0313-01)

The following table lists the relationships between RS-449 data rates
and cable lengths.

RS-449 Cable Lengths

Data Rate (in Kbps) Cable Length
56 or 64 4000 feet (1200 meters)
384 1476 feet (450 meters)
768* 575 feet (175 meters)

*For reference only. The Live50 and Live100 support data rates up to
and including 384Kbps.

V.35 Cable Lengths
The maximum V.35 cable length is 100 feet (30 meters).
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Installing the
384 Kbps Option

This appendix tells you how to install the 384 Kbps option that
allows the PictureTel Live application to transmit at any adjustable
rate from 128 to 384 Kbps. The transmit rate is established outside of
the Live application by either an IMUX or other communcation
device in a network configuration.

The 384 Kbps option should be installed after installing the
hardware and software for the Live application. The 384 software is
provided as a separately purchased option and comes on a single
diskette.

To install the 384 Kbps option:

1. From either the Windows 3.1x Program Manager or the Windows
95 Start Menu, select the Run ... program.

Windows displays the 3.1x Run dialog box.

=| Hun

Command Line:

| | Cancel

(] Run Minimized Browse._ .

J1

2. Insert the 384 disk and enter a:\setup in the Run dialog box.

The setup program installs the software and your Live application
can now operate at rates higher than 128 Kbps.
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How to Order
ISDN in the
United States

You need to order an ISDN BRI line to operate the PictureTel Live
PCS application. An ISDN BRI line can take several weeks to install
from the time you order. We recommend you plan ahead. Also,
check with your provider on whether you need a Network
Termination Device (NT1).

This appendix provides you with the following information:
0 What to ask your telephone company.
0 What information you need to give your telephone company.

o A list of telephone numbers for regional and long distance
ISDN providers.

0 A list of companies that manufacture or distribute Network
Termination Devices ,or NT1s.
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What to Ask You need to ask for following information from your telephone
company:
o What type of ISDN switch will connect your ISDN line?

The most common ISDN switch types are AT&T 5ESS, Northern
Telecom DMS-100, and Siemens EWSD NI1 (as detailed in the
following tables).

o What type of ISDN service will I be receiving?

Two of the most common types are Custom or National (as
detailed in the following tables). If Custom service is available,
find out if it is a point-to-point or a multi-point connection.

0 What is your dialing number?

0 What are your Service Provider Identification Numbers
(SPIDs)?

What You Need to On the next few pages of this appendix are 5 tables that can help you
Provide expedite the ISDN installation process.

The following 3 tables list the line provisioning required for the
PictureTel Live PCS application:

o AT&T 5ESS Switch Information
a Northern Telecom DMS-100 Switch Line Information
o Seimens EWSD NI-1 Switch Settings

The following 2 tables provide phone numbers for ordering ISDN
service and NT1 devices.

o ISDN Ordering Phone Number Listing
o Network Termination Device (NT1) Sources

You can fax or mail this information to your telephone company.



What You Need to Provide

AT&T 5ESS Switch Information

Custom Custom National ISDN National ISDN
. A (NI-1 and NI-2) (NI-1 and NI-2)
Veri:?g"hZis or Ver?_:?gnhgis or Version 5E8 or Version 5E8 or
IR P Higher** Higher**
Non-Initializing Fully initializing NI-2 - 1 DN NI-1 - 2 DNs
Line Code 2B1Q* 2B1Q* 2B1Q* 2B1Q*
Digital Subscriber Line Point-to-Point Multipoint Standard Standard
(DSL)
Service Provider ID Not needed for this Two required One assigned by Two assigned by
(SPID) configuration telephone company telephone company.

Directory Numbers (DN)

One is assigned for
both B-channels

Two required. One
for each B-channel

One is assigned for
both B-channels

Two (one for each B-
channel)

DSL CLS Point-to-Point Multi-point

B1 SERV DMD for circuit DMD for circuit DMD for circuit DMD for circuit
switched voice/data switched voice/data switched voice/data switched voice/data

B2 SERV DMD for circuit switch DMD for circuit DMD for circuit DMD for circuit switch
data switch data switch data data

D-Channel Signaling only (no Signaling only (no Signaling only (no Signaling only (no
packet-switched data) packet-switched packet-switched packet-switched data)

data) data)

CSsv 1 1 1 1

CSV CHL B1 B1 Bl B1

CSD 2 2 2 2

CSD channel Any Any Any Any

CSV LIMIT 1 1 1 1

CSD LIMIT 2 2 2 2

MAXB CHNL (maximum Must be set to 2. Must be set to 2. Must be set to 2 Must be set to 2

B-channel)

MTERM 1 2 2 2

TERMTYP (Term. type) Type A Type A Type A Type A

ACT USR Must be set to YES Must be set to YES Must be set to YES Must be set to YES

* Software releases prior to 5E6 (5E5 and 5E4.2) support only AMI line coding.
** NI-1 was first supported in the 5E8 software release

NOTE: Most SPIDs have one of the following formats: 01-7 digit DN, and an optional digit (for example, 01-332-7834-1, or any 3
digits (usually an area code), 7 digit DN, additional optional digits (for example, 700-737-3290-01).
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Northern Telecom DMS-100 Switch Line Information

Custom National
Load BCS-33 ISDN-1 (NI-1)

(PVC-1) Load BCS-35
Line Code 2B1Q 2B1Q*
Digital Subscriber Line (DSL)
Service Provider ID (SPID)

Two Two
Directory Numbers (DN) Two
Two(one for each B-channel)

Provisioning Parameters B1 B1

Set circuit switch toYes

Set circuit switch toYes

Set Bearer Restriction to NOPMD (No
Packet Data)

Set Bearer Restriction to NOPMD Must be set
to 2

Functional Terminal Adapter

Functional Terminal Adapter

Set TEI to Dynamic Set TEI to Dynamic
Set Ring to Yes Set Ring to Yes
Set EKTS to No Set EKTS to No
Set data option: PROVLLC CMDATA (lower
layer compatibility)
Provisioning Parameters B2 B2

Set circuit switch toYes

Set circuit switch toYes

Set BearerRestriction to NOPMD Must be
set to 2

Set BearerRestriction to NOPMD Must be set
to2

Functional Terminal Adapter

Functional Terminal Adapter

Set TEI to Dynamic Set TEI to Dynamic
Set Ring to Yes Set Ring to Yes
Set EKTS to No Set EKTS to No

Set data option: PROVLLC CMDATA (lower
layer compatiibility)
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Siemens EWSD NI-1 Switch Settings

Information Category Specific Options

Line Code 2B1Q

Digital Subscriber Line (DSL) National*

Provisioning Parameters BCHDNS = 2 (directory numbers assigned by telephone company)
BCDN = C56

BCDN = C64 (if supported by interexchange carrier to local central office)

CT = CMD (circuit mode data)

TSPIDs assigned by telephone company: Two

BRI should be provisioned as follows:

Subscriber

- Set B1 CT = CMD (for circuit switched data/voice)

- Set B2 CT = CMD (for circuit switched data)

-BCHCT =2

-IBCHCT =2

-OBCHCT =2

- COS = NICND (class of service; no ISDN calling # delivery)

- PIC = XXX-C56 (where XXX is the interexchange carrier’s code)

- PIC = XXX-C64 (where XXX is the interexchange carrier’s code)

Terminal Service Profile Data: - USID =1 (user ID)
- TSPID = 7085551234001 (for illustration purposes)

- TERMLIM = 1 (maximum number of terminals that can share this SPID)

-CT =CMD

- FKMPINUM = 0 (feature key management profile index number)

Access Data: - BCHEQN = 2 (number of B-channels assigned)

-BEQN = SP & AU3 & C56 & C64 (bearer capabilities on BRI)

- COE = CLASSI (class of equipment)

- LINKOPT = DYNNOPL (dynamic link, no packet links)

- CPDDN = 7085551234-CMD - The directory numbers assigned bt the telephone
company must match the bearer capabilities requested. In this example, the single
number listed is for circuit mode data. For this application, two DN’s are requested.

- CPVDN2 = 7085551235

* NI-1 was first supported in the APS 11 software release.

NOTE: Some fields might vary from one switch to another. Voice DN might be different from CMD DN.
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ISDN Ordering
Phone Number

The following numbers should be helpful in contacting telephone
provides for ISDN services. The first table provides the numbers for
regional telephone providers, and the second table lists the long

LIStlng distance carriers that offer ISDN lines and services.
ISDN Regional
' 1eg Telephone Number(s)
Provider
Ameritech 1-8-432-ISDN
Bell Atlantic 1-800-570-ISDN (all except New Jersey Bell)

1-800-843-2255x4736 (N ] Bell customers)

Pacific Bell 1-800-4PB-ISDN (ISDN Service Center)

1-800-995-0346 (ISDN Hotline)
1-800-662-0735 (ISDN Telemarketing)
1-800-995-0346 (24 Hour Hotline)

Bell South

1-800-428-ISDN (Technical Support)
1-800-858-9413 (Sales)

Cincinnati Bell

513-566-DATA (ISDN information )

GTE Call locally for ordering information
Nevada Bell Call locally for ordering information
NYNEX 1-800-650-4736

Southwestern Bell

214-268-1403 (Dallas/Ft. Worth)
713-567-4300 (Houston)
512-351-8050 (San Antonio)
1-800-SWB-ISDN (Austin)

US West

1-800-728-4949 ( FAX-Back)
1-800-246-5226 (small business).

ISDN Long Distance
Carriers

Telephone Number(s)

AT&T 1-800-222-7956 (Commercial)
1-800-820-6464 (Residential)

MCI 1-800-624-4736

Sprint 703-689-5743

Bell South 1-800-428-ISDN




NT1 Sources

NT1 Sources

The following numbers should be helpful in contacting companies

that manufacture or market Network Termination Devices (NT1).

Company

Address and Telephone Number(s)

Adtran, Inc.

901 Explorer Boulevard
Huntsville, AL 35806-2807
205-971-8000
1-800-788-5408 Sales

Bell Atlantic
Teleproducts

West Building, Suite 150
50 E. Swedesford Road
Frazer, PA 19355
1-800-221-0845

Motorola UDS

5000 Bradford Drive
Huntsville, AL 35805-1993
1-800-566-3266, ask for ISDN Lifeguard

PictureTel

100 Minuteman Road
Andover, MA 01810
1-800-716-6000

Tone
Commander
Systems

4379 150th Avenue NE
P.O. Box 97039

Redmond, WA 98073-9739
1-800-524-0024

FAX: 206-881-7179







Deinstalling
PictureTel Live
Version 1.6 (or
1.5) and
LiveShare Plus
Software

E

Deinstalling
Picturelel Live

This appendix tells you how to remove the PictureTel Live software
from your PC if you should ever need to do so.

These instructions assume that you installed the PictureTel Live 1.6
software in the directory C:\PICTEL\PCS (or C:\PCS for verison
1.5), and that Microsoft Windows is installed in directory
C:\WINDOWS. If this is not the case, you should substitute the
correct directory names.

To deinstall PictureTel Live version 1.6 (or 1.5) and PictureTel
LiveShare Plus software, follow these steps:
1. Preserve any phone books you want to save.

Phone books are files with the .PBK extension and the MDX
extension in the directory C:\PICTEL\PCS (or C:\PCS for
version 1.5). Copy or move these files to another directory.

2. Remove the PCS-related memory exclusion, if any, from the
CONFIG.SYS file.

3. Toremove the PictureTel LiveShare Plus software, select Run from
the Windows Program Manager File menu, and enter the full path
name of DEINSTAL.EXE

The typical path name is:
C:\PICTEL\LIVEPLUS\DEINSTAL.EXE
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4. Delete these files:
C:\WINDOWS\PCS100.INI
CAWINDOWS\VCSWIN.INI
C:\WINDOWS\*.PCS

5. Remove the PictureTel Live changes from the SYSTEM.INI file.

Use an editor to remove the changes from SYSTEM.INI,
following these steps:

a. In the [BOOT] section, change the line
COMM.DRV=C:\PCS\TDCOMM.DRV

by replacing C:\PCS\TDCOMM.DRV with the original driver
name. You will find this name in the [PICTELO1] section, on
the line that begins StdCommbDriver=.

For example, if you find this line in the [PICTELO01] section
StdCommDriver=COMM.DRV

then change the line in the [BOOT] section to
COMM.DRV=COMM.DRV

Or, if you find this line in the [PICTELO1] section
StdCommDriver=JANCOMM.DRV

then change the line in the [BOOT] section to
COMM.DRV=JANCOMM.DRV

b. In the [386ENH] section, remove the line

DEVICE=C:\PCS\PICTEL00.386

and similar lines, where 00 may be replaced with 01, 02, and
SO on.

c. In the [8386ENH] section, remove the EMM EXCLUDE
statement that corresponds to the PictureTel Live memory
address range:

EMMExclude
d. Entirely remove the section
[PICTELOO]

and similar sections, where 00 may be replaced with 01, 02,
and so on.
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6. Delete the directory where the software was installed, typically:
C:A\PCS

7. Run Windows Setup, and select a non-PictureTel VGA driver.

8. In Program Manager, delete the PictureTel Live PCS icon group.
If you plan to reinstall the PictureTel Live software:

1. Turn your PC off.

2. Turn your PC on again.

If you do not plan to reinstall the PictureTel Live software:
1. Turn off your PC.
2. Remove the PCS 50 or 100 hardware.

3. Enable or restore your original VGA hardware.
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Deinsta"ing To deinstall any PictureTel Live and LiveShare Plus software earlier
PictureTel Live than version 1.5, follow these instructions:
Versions Earlier 1. To remove the earlier version of PictureTel Live Share software,

than 1.5

select Run from the Windows Program Manager File menu, and
enter the full path name of REMOVE.EXE.

The typical path name is:
C:\PCS\LiveSHAR\REMOVE.EXE

. Preserve any PictureTel Live phone books that you want to save.

Phone books are files with the .PBK extension and the MDX
extension, typically found in the directory:

CAPCS

Copy or move these files to another directory.

. Remove the PCS -related memory exclusion from the CONFIG.SYS

file.

. Remove the PictureTel Live changes from the WIN.INI file.

Use an editor to remove the section:
[P2P /W]

. Remove the PictureTel Live changes from the SYSTEM.INI file.

Use an editor to remove the changes from the SYSTEM.INI file,
following these steps:

a. In the [BOOT] section, change the line:
COMM.DRV=C:\PCS\TDCOMM.DRV

by replacing C:\PCS\TDCOMM.DRYV with the original
driver name. You can find the original driver name in the
[PICTELO1] section, on the line that begins:

StdCommDriver=

For example, if you find this line in the [PICTELO1] section:
StdCommDriver=JANCOMM.DRV

then change the line in the [BOOT] section to:
COMM.DRV=JANCOMM.DRV
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b. In the [BOOT] section, restore the line:
user.exe=C:\PCS\LiveSHAR\user.exe
to:
user.exe=user.exe

c. In the [BOOT] section, restore the line
gdi.exe=C:\PCS\LiveSHAR\gdi.exe
to:
gdi.exe=gdi.exe

d. In the [386ENH] section, remove the line:
DEVICE=C:\PCS\PICTEL00.386

and similar lines, where 00 may be replaced with 01, 02, and
SO on.

e. In the [386] section, remove the EMM.EXCLUDE statement
that corresponds to the PictureTel Live memory address
range:

EMMExclude

f. Write down the system settings in the [PICTEL00] section,
so that you can use the same settings when you install the
1.5 version of the PictureTel Live software. These settings are
similar to the following lines:

PICTEL_IO=nnnn
PICTEL_IRQ=nn
PICTEL_MEM=nnnn

g. Entirely remove the section:
[PICTELOO]

and similar sections, where 00 may be replaced with 01, 02,
and so on.

h. Entirely remove the section:
[Live Share]

6. Delete these files:
C:A\WINDOWS\PCS100.INI
C:A\WINDOWS\VCSWIN.INI
CAWINDOWS\*.PCS
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7. Delete the directory where the software was installed, typically:
C:A\PCS

8. In Program Manager, delete the PictureTel Live PCS 100 icon
group.

9. Turn your PC off.

10. Turn your PC on again.
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Changing the
Video Mode
Setting

The video mode setting allows you to modify the video refresh rate,
which is a characteristic of your PC monitor.

Monitors support one or more video refresh rates. If your monitor
doesn’t support the PictureTel Live default video refresh rate, your
monitor display will appear distorted, and you'll need to change the
video mode setting.

To change the video mode setting, follow these steps:
1. Exit Windows.

2. Edit your AUTOEXEC.BAT file by adding the following line:
install-directorA\VGA\VMODE vmode

For the variable install-directory, substitute the name of the drive
and directory where you installed the PictureTel Live
applications (for example, C:\PCS).

For the variable vmode, substitute a setting from Table F-1 on the
next page. The column titled “then use this video mode setting”
lists all the possible settings. All but one of these settings are for
non-interlaced monitors.

Note: You can add one video mode line to your
AUTOEXEC.BAT file for each monitor resolution. If
you use the Windows Setup program to change the
display setting to a different VGA driver for a
different resolution, PictureTel Live automatically
sets the monitor characteristics based on that video
mode setting.

3. Reboot your system.
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Table F-1: Video Mode Settings

If you’re using and your monitor then use this
this monitor has these characteristics... video mode
resolution... setting: Notes
Horizontal Vertical
Frequency Frequency
640 x 480 31.50 kHz 60.00 Hz 60HZ Default setting for
this resolution
640 x 480 37.86 kHz 72.81 Hz 72HZ
800 x 600 35.50 kHz 56.00 Hz 35K
800 x 600 38.00 kHz 60.00 Hz 38K
800 x 600 48.40 kHz 72.70 Hz 48K Default setting for
this resolution
1024 x 768 49.00 kHz 60.00 Hz 65M Default setting for
this resolution
1024 x 768 56.48 kHz 70.07 Hz 72M
1024 x 768 35.50 kHz 87.00 Hz 45M Interlaced monitor
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Installation
Requirements

Outside of the
United States

This appendix contains the following information:

o BABT (British Approvals Board for Telecommunications)
requirements for installing the Live50 and Live100 (formerly
PCS 50 and PCS 100) boards in countries for which the pan
European approval applies.

o AUSTEL requirements for installing the Live50 and Livel00
(formerly PCS 50 and PCS 100) boards in Australia.

The following sections describe the BABT and AUSTEL
requirements that must be met for the approval to be valid.

The following statement describes the installation requirements for
BABT approval in the United Kingdom (not required for pan
European approval):

o The PictureTel Live50 and Livel00 boards are approved for
installation in a host, and with host attachments which are
either type approved for such apparatus, or, if supplied after
March 1, 1989, are marked with or supplied with a statement
that the host is supplied under General Approval Number
NS/G/1234/]/100003. (United Kingdom only.)

The following statements describe the installation requirements for
AUSTEL approval:

0 The PictureTel Live50 and Livel00 boards shall only be
installed in a Personal Computer (PC) that complies with the
AUSTEL criteria of “Data Terminal Equipment” as defined by
the Telecommunications Act of 1991, Notice Under Section 267
(No. 1 of 1993).
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Safety
Information

o The PictureTel Live50 and Livel00 boards shall only be
installed in a PC that requires the use of a tool before access can
be gained to internal parts.

0 The telecommunications line connection must be disconnected
from the PC before removing any external covers and shall be
reconnected only after all external covers are replaced.

0 The PictureTel Live50 and Livel00 boards shall only be
installed if the clearance and creepage distances between
adjacent cards are equal to or greater than 4mm and 5mm
respectively.

0 A warning label is provided with the PictureTel Live50 and
Livel00 boards and shall be attached to the PC in a visible
position. The label shall contain the following wording:

Telecommunications network voltages exist inside the PC. The
line connection must be disconnected before removing covers
and reconnected only after covers are replaced.

The following statements describe the safety requirements for BABT
and AUSTEL approval.

The Live50 and Livel00 boards are designed for use with an IBM
compatible PC. The network interface for the Live50 and Live100
boards is a TNV (Telecommunications Network Voltage) port
working within the limits of SELV (Safe Extra Low Voltage). The
connection to the PC bus is a SELV port.
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The Live50 board has the following ports for connection to the
network and other apparatus:

Table G-1: Live50 Board Port Connections

Type of Circuit

Port Location

Port Description

SELV J1 CHI to MVIP Connection
TNV ]2 ISDN Basic Rate Interface
SELV 13 @ Speakerphone

SELV J5 Speaker Output

SELV J6 O Microphone Input

SELV J7 X Video Input

SELV P1 VAFC Bus

SELV P2 ISA PC Bus

The Live100 board has the following ports for connection to the
network and other apparatus:

Table G-2: Live100 Board Port Connections

Type of Circuit

Port Location

Port Description

SELV J082 MVIP Connection

TNV J397 ISDN Basic Rate Interface
SELV 1898 Speakerphone

SELV J698 Aux Audio In/Out

SELV J598 Aux Audio In/Out

SELV Jo73 ISA PC Bus

SELV J157 Interboard connector
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Power
Requirements

The following statements describe the power requirements for
BABT and AUSTEL approval.

The Live50 and Livel00 boards are powered from the host chassis
and have the following power requirements per board:

Table G-3: Power Requirements

Voltage Current (max.)
+5V (+/-.25V) 3.25A
+12V (+/-.5V) 5A

The power drawn from the host chassis together with that required
for any other expansion boards and accessories must be within the
power rating of the host chassis.

The Live50 and Live100 boards must be installed in such a way that
the integrity of the network protection from hazardous voltages
used or generated internally by the host chassis is not impaired.

The clearance and creepage distances shown as X and Y in
Figure G-1 and as listed in Table G-4 must be maintained between
the Live50 or Livel00 boards and:

o The host chassis in which it is installed

0 Any adjacent expansion boards installed in the host chassis
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The exception to this requirement is the edge connector, which is
located in the host chassis power and data bus slots, where no
minimum distance applies.

Table G-4: Clearance and Creepage

Voltage used or
generated by other
parts of the host or

expansion bus

Clearance Xmm | Creepage Ymm

2.0 24 (3.8) up to 50Vrms or Vdc

2.6 3.0 (4.8) up to 125Vrms or Vdc

4.0 5.0 (8.0) up to 250Vrms or Vdc

4.0 6.4 (10.0) up to 300Vrms or Vdc

*See Note *See Note Above 300Vrms or
Vdc

Note: For a host or other expansion card fitted in the host,
using or generating voltages greater than 300V (rms or
dc), advice from a competent telecommunications safety
engineer must be obtained before installation of the
relevant equipment.

The creepage distances shown apply in a normal office
environment. Where the local environment within the host chassis
is subject to conductive pollution or dry nonconductive pollution
which could become conductive due to condensation, the creepage
distances shown in parentheses will apply. The clearance and
creepage between adjacent points should be checked as follows
(refer to Figure G-1):

o The clearance distance (X) is the shortest distance measured
between two points through the air.

o The creepage distance (Y) is the shortest distance between two
points measured across a surface.

The user should obtain advice from a competent
telecommunications safety engineer if in doubt.
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Live50/Live100 board  Adjacent board

—— ]

C
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Power supply unit
or other source of
excessive voltage

€

Figure G-1: PictureTel Live50 and Live100 Boards
Clearance and Creepage



Overview

Configuration
Tips

H

Performance Tips

The following technical tips will help you get the best results with
PictureTel Live and LiveShare Plus, especially on systems that have
slower processors and use many device drivers.

The following tips related to statements in your CONFIG.SYS,
SYSTEM.INI, and AUTOEXEC.BAT files:

o Make sure your CONFIG.SYS file contains the following lines:

device=c:\dos\himem.sys
device=c:\dos\emm386.exe noems x=d000-d3FF
BUFFERS=30

FILES=40

dos=high,UMB

This assumes that you are using memory addresses D000-D3FFE.
The number of buffers should be at least 30, and the number of
files at least 40.

o Confirm that your SYSTEM.INI file also excludes the correct
memory areas. For example, if you are using addresses D000-
D3FF, it should contain these lines:

Device=D:\PCS\PICTEL01.386
EMMExclude=D000-D3FF

If there are additional exclusions for other devices, they must
also be excluded from the memory manager line of your
CONFIG.SYS file.

o Make sure your AUTOEXEC.BAT and CONFIG.SYS files load
as many drivers into high memory as possible, in order to free
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up lower memory. These are examples from a CONFIG.SYS
file:
DEVICEHIGH=C:\\SCS\MA13B.SYS
DEVICEHIGH=C:\SCSN\NECCDR.SYS /d:NECCD

Experiment with the loading order of the drivers to force the
most efficient use of memory. You can check current memory
allocation using this DOS command:

mem /c

Note: Please refer to your Windows documentation for more
information about the CONFIG.SYS and SYSTEM.INI
files.

Memory Tips The following tips relate to swap files and memory usage:

0 In order to improve overall Windows performance when you
run other programs along with PictureTel LIVE, you should
configure your system with a Swap File, preferably a
permanent one.

To configure your Swap File, open the Control Panel, choose 386
Enhanced, and then choose Virtual Memory. You can use the
type and size of Swap File the system recommends as the
default.

o If you are experiencing Windows’ messages relating to
insufficient memory, try launching PictureTel Live before your
other Windows applications.
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Configuration
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Laptop Docking
Station
Configuration

If you install PictureTel Live on a laptop docking station, you need
to make special provisions for using your laptop both in and out of
the docking station. This involves creating a batch file that lets you
choose between docked and mobile configurations when starting
up your laptop.

After installing the PictureTel Live software, follow these steps to
create a batch file that allows you to choose between a docked or
mobile configuration during start-up. Perform these 5 steps with the
laptop connected to the docking station:

1. Copy SYSTEM.INI to SYSTEM.DOC.

2. Run the Windows setup program and change your video driver to
VGA.

3. Try undocking the laptop and running Windows. If everything
works properly, copy SYSTEM.INI to SYSTEM.LAP.

4. Create an AUTOEXEC.BAT file that will prompt you for either the
docked or mobile configuration when you start up. Here is one
you can use or modify:

@ECHO OFF

PROMPT $p$g

PATH C:\;C:\WINDOWS;C:\DOS;C:\NECUTILS
SET TEMP=CA\TEMP

IF NOT EXIST VERSION. GOTO SETUP

CLS

I-1
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TYPE VERSION

:SETUP
LH /L:0;1,16400 /S C:\WINDOWS\SMARTDRV.EXE
rem ============= PCMCIA2 Device Drivers

rem == |[f PCMCIA cards are not used in your system, these
rem == drivers can be remarked to save system memory area.
rem
LOADHIGH C:\PCMCIA2\CS_APM.EXE

rem MENU

rem ==The following statement will get values from CONFIG.SYS
rem == for mobile or docked configurations.

rem

goto %CONFIG%
:DOCKED
rem

rem == Add to this section any drivers, etc., that are unique
rem == to the docked configuration.

rem
\necutils\BACKLITE FULL

rem ==The following statement changes the video mode for an

rem ==alternative video source.

\necutils\videomod ¢

rem ==The following statement copies the docking station's

rem ==SYSTEM.DOK to the required SYSTEM.INI name. Note that
rem ==if you make any changes to SYSTEM.INI, you must copy
rem ==them to SYSTEM.DOK in order for this to continue to work
rem ==correctly.

copy==\windows\system.dok \windows\system.ini

rem==echo .

goto END

:MOBILE

rem

rem ==Add to this section any drivers, etc., that are unique
rem ==to the mobile configuration.
rem

rem ==The following statement changes the video mode to the
rem ==LCD display

\necutils\videomod |

rem ==The following statement copies the laptop's
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rem ==SYSTEM.LAP to the required SYSTEM.INI name. Note that
rem ==if you make any changes to SYSTEM.INI, you must copy
rem ==them to SYSTEM.LAP in order for this to continue to work
rem ==correctly.

copy \windows\system.lap \windows\system.ini

:END

5. Add an appropriate section to your CONFIG.SYS file to go along
with the AUTOEXEC.BAT file, such as this one:

[MENU]

rem === =

rem ==The following is a menu which will allow you to choose
rem ==separate configurations for Mobile or Docked.

rem === —
MENUITEM=MOBILE, Mobile Configuration
MENUITEM=DOCKED, Docked Configuration

rem === =

rem ==Change the following timer value for the most
rem ==appropriate setting. For example, change the 10 to 5
rem ==or a 5-second delay.

rem === =
MENUDEFAULT=MOBILE, 10

MENUCOLOR=1,3

[DOCKED]

rem === =

rem ==Add to this section any drivers, etc., that are unique
rem ==to the docked configuration.

rem === —
[MOBILE]
rem === —

rem ==Add to this section any drivers, etc., that are unique
rem ==to the mobile configuration.

rem === =
rem DEVICEHIGH=C:\DOS\POWER.EXE
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Ordering
and Returning
Components

This appendix tells you how to order and return PictureTel Live 50
and 100 components.

Ordering To order replacement components:

Com ponents 1. Locate the appropriate part number using the tables in this
appendix.

2. Call PictureTel Customer Services at 800-874-2835 or
508-292-5999, or call your local PictureTel distributor.

J1
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Live 50 Part The following table lists part numbers for the PictureTel Live 50
Numbers product components.
Component Part Number
Live 50 board 500-0145-02
VGA board with VESA Advanced Feature | 520-0508-01
Connector (ISA bus) or
520-0508-02
VGA board with VESA Advanced Feature | 370-0258-01
Connector (PCI bus)
VAFC cable 510-0206-01
Camera (NTSC) 370-0242-01
Camera (PAL) 370-0243-01
Earpiece 370-0260-01
Speakerphone unit 520-0490-02
Speakerphone handset 370-0262-01
Speakerphone handset cord 180-0204-01
Speakerphone cable 510-0165-01
Speakerphone power supply (optional) 300-0013-01
ISDN BRI cable 180-0005-01
Network Interface MVIP cable 180-0293-01
FlipCam Adapter cable 510-0244-01
FlipCam Camera (NTSC) 520-0615-01
FlipCam Camera (PAL) 520-0616-01
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Live 100 Part Numbers

Live 100 Part

Numbers

The following table lists part numbers for the PictureTel Live 100

product components.

Component Part Number
VGA Video board 500-0109-04
Audio Communications board 500-0089-04
Interboard ribbon cable 510-0172-01
FlipCam camera (NTSC) 520-0250-03
FlipCam camera (PAL) 520-0251-03
Camera stand 520-0252-01
Camera cable 510-0164-01
Speakerphone 520-0253-02
Speakerphone handset 370-0169-01
Speakerphone handset cord 180-0133-01
Speakerphone cable 510-0165-01
Speakerphone power supply (optional) 300-0013-01
FlipCam camera 10-meter cable (optional) | 510-0183-01
Auxiliary Audio cable (optional) 510-0162-01
ISDN BRI cable 180-0005-01
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Returning
Components

When you return a part to PictureTel, ship only the part that requires
repair. For example, if a board needs repair, separate all cables from
the board, and send the board without the cables.

To return PictureTel Live components:

1. Request a return material authorization (RMA) number.
You can request an RMA in two ways:

a Call PictureTel Customer Services at 800-874-2835
or 508-292-5999.

o Send a FAX to PictureTel Customer Services at 508-292-3333.
2. Wrap the component in an antistatic bag, if necessary.

3. Pack the component in a shipping container, using bubble wrap as
needed.

4. Mark the outside of the shipping container with the RMA number.

5. Send the container to your local PictureTel distributor or to this
address:

Customer Services Logistics
PictureTel Corporation

One Centennial Drive
Peabody, MA 01960-9970
US.A.
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	Installing PictureTel Live50 Hardware
	Overview

	In this Chapter
	Checking Your PC Settings
	1. Begin by checking your PC documentation, then check the manufacturer’s documentation for setti...
	2. As you check the manufacturer’s default settings, check to see if you changed any of their def...
	3. If your PC has an ISA bus, you can then run the Microsoft Diagnostics program, as described in...
	4. Write down the settings that are already in use.
	5. Compare your list of settings that are in use with the default settings for the Live50.
	6. If there is a conflict, change the settings in your Live50, as described in Appendix B.

	Opening Your PC
	1. Power off your PC.
	2. Disconnect your monitor cable, and other cables if necessary, from the PC chassis.
	3. Remove the chassis cover.

	Replacing Your VGA Board
	1. Remove your current VGA board (or follow the instructions in your PC documentation for disabli...
	2. Insert the VGA board shipped with your Live50 system.

	Installing the Live50 Board

	Inserting the Live50 Board
	1. Power off your PC.
	2. Locate an available ISA or EISA expansion slot next to the VGA board, or locate the next avail...
	3. Remove the back plate of the expansion slot and save the screw.
	4. Remove the Live50 board from its plastic antistatic package.
	5. Check Switch 1 on the board to make sure it is set as shown below.
	6. Insert the board into the expansion slot next to the VGA board, or into the next available slot.
	7. Secure the board by replacing the screw that holds the back plate.

	Connecting the Live50 Board to the VGA Board
	1. Connect one end of the VAFC cable to the VESA Advanced Feature Connector on the top of the Liv...
	2. Connect the other end of the VAFC cable to the VESA Advanced Feature Connector on the VGA board.
	Installing Optional Network Interface Boards
	Labeling the Live50 Board
	1. Peel off the label.
	2. Attach the label to your PC chassis to the left of the Live50 board, with the triangles pointi...

	Closing Your PC
	Connecting the Cameras

	Connecting the Live50 Desktop Camera
	1. Plug one end of the video cable into the socket labeled on the camera.
	2. Plug the other end of the video cable into the socket labeled on the Live50 board.
	3. Plug the AC power adapter cable into the socket labeled on the camera.
	4. Do one of the following:
	Mounting the Live50 Desktop Camera


	Connecting the Live50 FlipCam Camera
	1. Tilt the camera body up and away from its circular base, as shown in the illustration below.
	2. Locate the 8-pin FlipCam cable, with plugs labeled .
	3. Plug the end of the cable without the ferrite bead into the socket at the back of the camera n...
	4. Press the cable into the guide on the camera base.
	5. Connect the Live50 FlipCam Adapter cable to the FlipCam cable.
	6. Be sure your PC is turned off.
	7. Plug the yellow connector at end of the FlipCam Adapter cable into the camera socket labeled o...
	8. Plug the male end of the parallel section of cable on the FlipCam Adapter into the female sock...
	Mounting and Positioning the FlipCam

	The FlipCam camera is designed with flexibility in mind. You can mount it in several ways, and yo...
	Camera Mounting Options

	Connecting the Earpiece
	1. Plug the black connector with the speaker icon into the socket labeled on the Live50 board.
	2. Plug the red connector with the microphone icon into the socket labeled on the Live50 board.

	Connecting the Speakerphone Unit
	3. Plug the other end of the speakerphone cable into the socket labeled on the speakerphone unit,...
	4. Plug one end of the handset cable into the socket labeled on the speakerphone unit.
	5. Plug the other end of the handset cable into the handset.

	Connecting Optional Equipment to the Speakerphone
	Connecting Other Audio Devices
	1. Plug the stereo connector from the amplified speakers into the socket labeled on the Live50 bo...
	2. Plug the connector from the microphone into the socket labeled on the Live50 board.

	Connecting to the Network

	From the Live50 Board
	1. Plug one end of the 8-pin modular network cable into the RJ-45 socket labeled ISDN on the Live...
	2. Plug the other end of the cable into the network service jack.

	From a Network Interface board
	Restarting Your PC
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	Installing PictureTel Live100 Hardware
	Overview

	In this Chapter
	Checking Your PC Settings
	1. Begin by checking your PC documentation, then check the manufacturer’s documentation for setti...
	2. As you check the manufacturer’s default settings, check to see if you changed any of their def...
	3. If your PC has an ISA bus, you can then run the Microsoft Diagnostics program, as described in...
	4. Write down the settings that are already in use.
	5. Compare your list of settings that are in use with the default settings for the Live100.
	6. If there is a conflict, change the corresponding switch settings in your Live100 boards, as de...


	Opening Your PC
	1. Power off your PC.
	2. Disconnect your monitor cable, and other cables if necessary, from the PC chassis.
	3. Remove the chassis cover.
	4. Remove your VGA board if it is a separate board, or disable VGA on the motherboard.
	5. Locate two adjacent full-size expansion slots.
	6. Remove the back plates of your selected expansion slots and save the screws.


	Installing the VGA Video Board
	1. Remove the VGA Video board from its plastic antistatic package.
	2. Insert the board into the selected expansion slot.
	3. Secure the board by replacing the screw that holds the back plate.


	Installing the Audio Communications Board
	1. Remove the Audio Communications board from its plastic antistatic package.
	2. Insert the board into the expansion slot adjacent to the VGA Video board.
	3. Secure the board by replacing the screw that holds the back plate.


	Connecting the Live100 Boards Together
	1. Grasp the connector on one end of the ribbon cable so that you can squeeze the tabs along the ...
	2. Line up the key on this connector with the interboard connector on top of one of the Live100 b...
	3. Slide the key into the interboard connector while squeezing the tabs, keeping the top of the c...
	4. Click the tabs into the locks on the sides of the interboard connector.
	5. Repeat these steps to connect the other end of the ribbon cable to the other board.


	Installing Optional Network Interface Boards
	Attaching Labels
	1. Locate the sheet of labels for the Live100 boards.
	2. Peel off the label that includes the “VGA” marking.
	3. Attach this label to your PC chassis to the left of the VGA Video board, with the triangle at ...
	4. Peel off the label that includes the “ISDN” marking.
	5. Attach this label to your PC chassis to the left of the Audio Communications board, with the t...


	Closing Your PC
	Reconnecting Cables
	1. Connect your monitor cable to the 15-pin connector labeled VGA on the VGA Video board.
	2. Reconnect any other PC cables you disconnected earlier.


	Connecting the FlipCam Camera

	Connecting the FlipCam to the PC
	1. Tilt the camera body up and away from its circular base, as shown below.
	2. Locate the 8-pin FlipCam cable, with plugs labeled .
	3. Plug the end of the cable without the ferrite bead into the socket at the back of the camera n...
	4. Press the cable into the guide on the camera base.
	5. Be sure your PC is turned off.
	6. Plug the end of the cable with the ferrite bead into the socket nearest the VGA connector on t...


	Mounting and Positioning the FlipCam
	Connecting the Speakerphone Unit
	1. Be sure your PC is turned off.
	2. Locate the 7-pin speakerphone unit cable, with plugs labeled .
	3. Plug one end of the speakerphone cable into the socket labeled on the speakerphone unit, align...
	4. Plug the other end of the speakerphone cable into the socket labeled on the Audio Communicatio...
	5. Plug one end of the handset cable into the socket farthest to the right on the back of the spe...
	6. Plug the other end of the handset cable into the handset.


	Connecting Optional Equipment to the Speakerphone

	Connecting the Headset
	Connecting the Power Supply
	1. Plug the power supply cable into the power socket labeled on the back of the speakerphone unit.
	2. Plug one end of the power cord into the power supply.
	3. Plug the other end of the power cord into a wall outlet.

	Connecting to the Network

	From the Live100 Audio Communcations Board
	1. Plug one end of the 8-pin modular network cable into the RJ-45 socket labeled ISDN on the Audi...
	2. Plug the other end of the cable into the network service jack.


	From a Network Interface board
	Optional Devices

	Connecting a Second FlipCam Camera
	1. Be sure your PC is turned off.
	2. Plug the camera cable into the socket labeled that is farthest from the 15 pin VGA connector f...
	3. To enable the camera, power on your PC, bring up the PictureTel Live application, and from the...


	Connecting a VCR or Other Video Source
	1. Be sure your PC is turned off.
	2. Plug the VCR video-out cable into the yellow video-in socket labeled on the VGA Video board.
	3. Plug the Auxiliary Audio cable into the socket labeled or on the Audio Communications board.
	4. Plug the VCR audio-out cable into the audio-in socket on the Auxiliary Audio cable.
	5. Plug the VCR audio-in cable into the audio-out socket on the Auxiliary Audio cable.

	Restarting Your PC
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	Installing PictureTel Live Software
	Overview
	In this Chapter

	General Considerations
	Installing from a LAN
	1. Create installation directories on a convenient hard disk.
	2. Copy the installation disks to the new directories.
	3. Use these directories in place of the installation disks.


	Installation Steps
	1. The correct VGA Video Drivers for your PictureTel Live hardware need to be selected and instal...
	2. Insert the Live Disk 1 and run a:\setup to initiate the Setup Wizard.
	3. Install the Windows 3.1 or the Windows 95 version of LiveShare Plus. (After this install, Wind...
	4. Install the PictureTel Live application. (After this install, Windows will be restarted.)


	Installing the VGA Driver
	Windows 3.1x PictureTel VGA Driver Installation
	1. Open the Main program group and select (double-click) Windows Setup
	2. From the Options menu, select Change System Settings...
	3. Click on the Display bar or on the down arrow next to the Display bar.
	4. Press the down arrow until you highlight Other display (Requires disk from OEM)..., and press ...
	5. Insert the disk labeled VGA Driver into the diskette drive.
	6. Enter the appropriate drive at the prompt and press Enter.
	7. Highlight the VGA driver you want to use and press Enter.
	8. Press Enter to accept your selected VGA driver.
	9. Close the windows and return to the desktop
	10. Remove the VGA disk from the diskette drive.
	11. Open a Windows application to verify that the VGA board is working properly.


	Windows 95 Driver Selection
	1. Click on the Start button, point to Settings, and click on Control Panel.
	2. Double click on the Display icon.
	3. Click on the Settings tab page.
	4. Click on the Change Display type button.
	5. Click on the Change button in the Adapter Type area.
	6. Make sure the Show all devices setting is selected.
	7. Select Tseng Labs from the Manufacturers area and the Tseng Labs ET4000 /W32 driver from the M...
	8. Click OK to apply the change.
	9. Open a Windows application to verify that the VGA board is working properly.


	Windows 3.1x Non-PictureTel VGA Driver Installation
	1. Run the Setup program provided by the video board manufacturer.
	2. After you have completed the installation, remove the VGA installation disk from the diskette ...
	3. Open a Windows application to verify that the VGA board is working properly.


	Windows 95 Matrox Driver Installation
	1. Installing the Microsoft MGA Driver 1.0 (available as part of Windows 95)
	2. Installing the MGA PowerDesk upgrade (disk supplied with PictureTel Live50, Version 1.6)
	3. Adjusting the “Desktop Area” and “Display Area.”

	Step 1: Installing the Microsoft MGA Driver
	Step2: Upgrading to the PowerDesk Driver
	1. Insert the Matrox PowerDesk disk into Drive A:
	2. From the Start Menu, run A:\SETUP.EXE
	3. Confirm the installation path (C:\MATROX\MGA), or modify it, and press Next.
	4. Confirm the installation of both the MGA Monitor Program and Quick Access by pressing Next.
	5. If a message indicating that MGA.INF has been found is displayed, respond Yes to the questions...
	6. A “wizard” leads you through the process of selecting the updated MGA driver, using the standa...
	7. Restart the PC.


	Step 3: Adjusting Desktop Area and Display Area
	1. Click on the Start button, point to Settings, and click on Control Panel.
	2. Double click on the Display icon.
	3. Click on the MGA Settings tab page.
	4. Set the Desktop area to match the Display area (for example, 1024 x 768).
	5. Click OK to apply the changes.




	Starting the Setup Wizard
	1. From either the Windows 3.1x Program Manager or the Windows 95 Start Menu, select the Run ... ...
	2. Insert Disk1 :SETUP of the Live 50 or 100 installation disks, and enter a:\setup in the Run di...


	Installing LiveShare Plus
	Installing LiveShare Plus On Windows 3.1x and Windows 95
	1. Insert LiveShare Plus diskette 1 into the diskette drive (a: or b:).
	2. Set the Install Path to read from the correct diskette drive.
	3. Select (double-click) LiveShare Plus from the Wizard’s display box.
	4. Follow the instructions that appear on the screen.
	5. When the Choose Destination Location box appears, you can enter a custom installation location...
	6. Before you restart the computer, remove the diskettes from the drive.
	7. When installation is complete, store your LiveShare Plus diskettes in a safe place.



	Installing the PictureTel Live Application
	1. Insert DISK 1: SETUP of the Live50 or Live 100 Installation disks in drive a: or b: and enter ...
	2. Select (double-click) PictureTel Live (double-click) from the wizard’s display box.
	3. Fill in your name, your company, and the serial number of your PictureTel Live unit and press ...
	4. If the information is correct, press enter (or click the Yes button). If the information is in...
	5. Press enter (continue) to keep the default drive and directory or change them to be compatible...
	6. Setup displays the following window with the network interface choices your PC will use for vi...

	ISDN Protocol
	Selecting an ISDN protocol
	7. Enter the Service Provider IDs (SPIDs) for the B channels (in the United States and Canada only)
	8. If you are connecting your Live system to an ISDN network outside of North America, you may ne...
	9. You need to specify the Multiple Subscriber Numbers (MSNs) for those switches outside the Unit...
	10. In the next window you must specify the PC settings for the Live board.
	11. Specify a node name that identifies you and your PictureTel Live system to the other party du...
	12. If you are installing the Live50 software, the setup program performs an additional step and ...


	Reconfiguring Memory (optional step)
	1. Edit your CONFIG.SYS file to add an exclude statement to the line defining your extended memor...
	2. Allow the Setup program to reboot your PC.
	3. Once Windows has restarted, you may need to re-optimize your system, using your extended memor...


	Verifying Your Installation
	1. Start PictureTel Live.
	a. Exit Windows.
	b. Turn your PC off, and then on.
	c. Start Windows.
	d. Attempt to start PictureTel Live.
	2. Check your Local Video window to make sure that you can see the video image captured by your l...
	3. Choose Diagnostics from the Tools menu.
	4. Click the Loopback button.
	5. Click the hangup (or end test) button.
	6. Verify your Network connection. You should see the Ready message displayed at the bottom of th...




	Locating PictureTel Live Files
	What To Do Next
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	Troubleshooting
	Overview
	In this Chapter

	Problems Bringing Up DOS and Windows
	1. Change to the directory containing your Windows system files.
	2. Replace the new versions of the system files with the original versions of the files, by enter...
	3. Reboot your PC.
	Table 5 1: Problems Bringing Up DOS and Windows 


	Problems Starting Up PictureTel Live
	Table 5 2: Problems Starting Up PictureTel Live 
	1. Check these settings.
	2. Check your PC documentation to determine available settings; also check documentation for sett...
	3. Run the Microsoft Diagnostics (MSD) program to check the current IRQ settings and memory space...
	4. If you change any of these settings, run the Live Configuration utility in the PictureTel Live...
	5. Edit your CONFIG.SYS file to exclude the memory space. The default values are D000– D3FF.
	6. Refer to your PC documentation for instructions on how to confirm that shadow RAM has been dis...
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	Checking Your PC Settings
	Overview
	Using Auto Detect


	Under Windows 95
	Checking an ISA-Bus PC
	1. Start Windows and select MS-DOS prompt from the Main program group.
	1. From the Windows DOS prompt, type this command:
	2. Type q to select IRQ Status.
	3. Locate IRQ 11 and check if it is available.
	4. Press Enter to return to the Diagnostics program Main Menu.
	5. Type m to select Memory.
	6. Check if the memory address you set in the PictureTel Live Setup program is available.
	7. Press Enter to return to the Diagnostics program Main Menu.
	8. Press F3 to exit the Microsoft Diagnostics program.
	9. Review your PC documentation for conflicts with the I/O port address you set in the PictureTel...
	10. Review your PC documentation for additional conflicts.
	11. If you found any conflicts, change the settings by running the PictureTel Live Setup program ...


	Checking and Configuring an EISA-Bus PC
	1. Check your current PC settings for conflicts with the settings for IRQ, I/O port addresses, an...
	2. If you found any conflicts, change the settings by running the PictureTel Live Setup program a...
	3. Configure your PC for the Live50 and Live100 Audio Communications board.
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	Changing Settings on the Live100 Boards
	Overview
	Changing Settings on the VGA Video Board
	1. Remove the board from its plastic antistatic package.



	Figure B 1 shows the VGA Video board, which you can identify by the 15-pin VGA connector on the b...
	Figure B 1: VGA Video Board
	2. Place the board on a level surface so that its component side faces up and the back plate (wit...
	3. If the default I/O port address setting of 27CA–27CE conflicts with the I/O port address of an...
	a. Refer to Figure B 1 and locate switch SW1 on the board.
	b. Use a ballpoint pen to slide the DIP switch labeled ADR2 on SW1 to the right. This changes the...

	Changing Settings on the Audio Communications Board
	1. Remove the board from its plastic antistatic package.


	Figure B 2 shows the Live100 Audio Communications board, which you can identify by the MVIP conne...
	Figure B 2: Live100 Audio Communications Board
	2. Place the board on a level surface so that its component side faces up and the back plate (wit...
	3. If the default IRQ setting (IRQ 11) conflicts with the IRQ of another device in your PC, chang...
	a. Refer to Figure B 2 and locate switch SW962 on the board.
	b. Use a ballpoint pen to slide the DIP switch labeled 7, which is IRQ 11, down to the OFF position.
	c. Make sure all switches are down in the OFF position before proceeding to the next step.
	d. Slide the DIP switch for your selected IRQ setting up to the ON position.
	4. If the default I/O port address setting (0280) conflicts with the I/O port address of another ...

	a. Refer to Figure B 2 and locate switch SW570 on the Audio Communications board.
	Table B 1: Switch Settings for Hexadecimal Digits
	b. Use a ballpoint pen to slide the following DIP switches:
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	Installing Network Interface Boards
	Overview
	1. Install the Live50/Live100 hardware using Chapter 2, Installing PictureTel Live50 Hardware or ...
	2. Install the Switched-56 Network Interface board.
	3. Install the PictureTel Live application software using Chapter 4, Installing PictureTel Live S...

	1. Install the Live50/Live100 hardware using Chapter 2, Installing PictureTel Live50 Hardware or ...
	2. Install the DDM/Network Interface board.
	3. Install the PictureTel Live application software using Chapter 4, Installing PictureTel Live S...
	4. When the installation is complete, select Tools > Diagnostics > Loopback to test the audio and...
	5. Install the DDM/Network Interface board software as described later in this document.
	6. When the installation is complete, select Tools > Diagnostics > Loopback to test the integrity...



	In this Appendix
	Connection Types
	Installing the Switched-56 Network Interface Board
	Installing the Data-Dialer Module/Network Interface Board
	Installing the Data-Dialer Module/Network Interface Board Software
	Cable Pinouts
	Maximum Cable Length
	Before You Begin
	Switched-56 Kit
	Switched-56 Network Interface board
	Live50 CHI to MVIP cable (1)
	Live100 MVIP cable (1)
	Switched-56 chassis label (1)
	Loopback test cables (2)
	Switched-56 network cables
	PictureTel Live50/Live100 Network Interface Installation Guide

	DDM V.35 Kit
	DDM/Network Interface board
	Live50 CHI to MVIP cable
	Live100 MVIP cable
	V.35/RS-366 4-leg cable
	DDM/Network Interface board installation diskettes
	PictureTel Live50/Live100 Network Interface Installation Guide

	DDM RS-449 Kit
	DDM/Network Interface board
	Live50 CHI to MVIP cable
	Live100 MVIP cable
	RS-449/RS-366 4-leg cable
	DDM/Network Interface board installation diskettes
	PictureTel Live50/Live100 Network Interface Installation Guide
	Connection Types
	Integrated 4-Wire SW56
	Switched-56 Network Interface
	V.35 (or RS-449) dialed/ nondialed
	DDM/Network Interface
	Note: For V.35/RS-449 connections, CSU/DSUs (Channel Service Unit/Data Service Units) may be requ...


	Installing the Switched-56 Network Interface Board
	Switched-56 Network Interface board
	Live50 CHI to MVIP cable (1)
	Live100 MVIP cable (1)
	Switched-56 chassis label (1)
	Loopback test cables (2)
	Switched-56 network cables
	PictureTel Live50/Live100 Network Interface Installation Guide



	Unpacking the Switched-56 Network Interface Board
	1. Remove the board from the plastic antistatic package.
	2. Place the board on a level surface so that its component side faces up and the back plate (wit...


	Changing the IRQ Setting on the Switched-56 Network Interface Board
	Note: If the default IRQ setting (IRQ 15) does not conflict with the IRQ setting of another devic...
	1. Find the jumper block on the board.

	The jumper block is just above the edge connector at the bottom of the board. It has 12 pairs of ...
	2. Choose a setting other than 15 and identify the pair of pins that matches your chosen setting.
	3. Move the jumper to the new position.

	Remove the jumper shunt from the jumper block by lifting it straight up. Then align it over the c...

	Changing the I/O Port Address on the Switched-56 Network Interface Board
	Note: If the default I/O port address setting (01C0) does not conflict with the I/O port address ...
	0xy0
	0 is preset and is not defined by a switch.
	x is designated with switches 5 and 6 and can be digits 0, 1, 2, or 3.
	y is designated with switches 1 through 4 and can be digits 0 through F.
	0 is preset and is not defined by a switch.
	Note: These switch settings do not follow the same scheme as the settings on the Live100 Audio Co...
	1. Make sure that the back plate (with the connectors) is facing toward your right.
	2. For the digit in position x, set switches 5 and 6 accordingly.



	Use a thin, blunt instrument, such as a ballpoint pen.
	This digit can be a 0, 1, 2, or 3 only.
	3. For the digit in position y, set switches 1 through 4 accordingly.

	This digit can be 0 through F.

	Inserting the Switched-56 Network Interface Board into the PC
	1. Select an expansion slot that is no more than one slot away from the Live100 Audio Communicati...
	2. Remove the filler plate on the expansion slot you have selected for this board and save the sc...
	3. Insert the board into an available ISA expansion slot.
	4. Make sure the board is securely seated into the PC.
	5. Secure it with the screw that held the filler plate.


	Connecting the Switched-56 Network Interface Board
	Connecting the Live100 MVIP Cable
	1. Grasp the connector on one end of the ribbon cable.
	2. Line up the key on this connector with the slot on the expansion connector attached to the fro...
	3. Slide the key into the expansion connector slot.
	4. Repeat these steps to connect the other end of the ribbon cable to the Network Interface board.


	Connecting the Live50 CHI to MVIP Cable
	1. Grasp the 40-pin connector on one end of the cable.
	2. Line up the key on this connector with the slot on the expansion connector attached to the Net...
	3. Slide the key into the expansion connector slot.
	4. Connect the 8-pin connector to the Live50 board.

	Installing the DDM/Network Interface Board

	DDM V.35 Kit
	DDM/Network Interface board
	Live50 CHI to MVIP cable
	Live100 MVIP cable
	V.35/RS-366 4-leg cable
	DDM/Network Interface board installation diskettes
	PictureTel Live50/Live100 Network Interface Installation Guide

	DDM RS-449 Kit
	DDM/Network Interface board
	Live50 CHI to MVIP cable
	Live100 MVIP cable
	RS-449/RS-366 4-leg cable
	DDM/Network Interface board installation diskettes
	PictureTel Live50/Live100 Network Interface Installation Guide


	Unpacking the DDM/Network Interface Board
	Changing the I/O Port Address on the DDM/Network Interface Board
	Note: If the default I/O port address setting (3CC0) does not conflict with the I/O port address ...
	xyz0
	x is designated with switches 7 and 8 and can be digits 0, 1, 2, or 3.
	y is designated with switches 3 through 6 and can be digits 0 through F.
	z is designated with switches 1 and 2 and can be digits 00, 40, 80, or C0.
	0 (the last digit) is constant and has no associated switches.
	1. Make sure that the back plate (with the connectors) is facing toward your right.
	2. For the digit in position x, set switches 7 and 8 accordingly.


	Use a thin, blunt instrument, such as a ballpoint pen.
	This digit can be a 0, 1, 2, or 3 only.
	3. For the digit in position y, set switches 3 through 6 accordingly.

	This digit can be 0 through F.
	4. For the digit in position z, set switches 1 and 2 accordingly.

	Use a thin, blunt instrument, such as a ballpoint pen.
	This digit can be a 00, 40, 80, or C0 only.
	Note: Be sure to record your I/O port address. You must specify it during software installation.


	Inserting the DDM/Network Interface Board into the PC
	1. Select an expansion slot that is no more than one slot away from the Live100 Audio Communicati...
	2. Remove the filler plate on the expansion slot you have selected for this board and save the sc...
	3. Insert the board into an available ISA expansion slot.
	4. Make sure the board is securely seated into the PC.
	5. Secure it with the screw that held the filler plate.


	Connecting the DDM/Network Interface Board
	Connecting the Live100 MVIP Cable
	1. Grasp the connector on one end of the ribbon cable.
	2. Line up the key on this connector with the slot on the expansion connector attached to the fro...
	3. Slide the key into the expansion connector s Repeat these steps to connect the other end of th...


	Connecting the Live50 CHI to MVIP Cable
	1. Grasp the 40-pin connector on one end of the cable.
	2. Line up the key on this connector with the slot on the expansion connector attached to the Net...
	3. Slide the key into the expansion connector slot.
	4. Connect the 8-pin connector to the Live50 board.

	Installing the Data-Dialer Module/Network Interface Board Software
	1. Install the Live50/Live100 application software, as instructed in Chapter 4, Installing Pictur...
	2. Fromthe Windows 3.1x Program Manager, Select File...Run. From the Windows 95 Start Menu, selec...
	3. Type A:SETUP or B:SETUP. Press Enter, and follow the on-screen instructions to install your so...
	4. When the software installation is complete, select PictureTel Live50/Live100 Configure from th...
	5. The Registration Confirmation window is displayed.

	Click Continue.
	6. .The Network Interface Settings window is displayed.

	If the V.35/RS-449 will be your only Network Interface, toggle off the ISDN BRI check box, and se...
	When you have selected the appropriate Network Interface settings, click Continue.
	7. The Hardware Settings window is displayed.

	In the Hardware Type field, select Integrated data-dialer module. Then click Continue.
	8. The DDM Base I/O Address and DDM IRQ fields appear on the Hardware Settings window.

	This window illustrates the default DDM base I/O address setting. If your DDM base I/O address se...
	If no changes are required, click Continue.
	9. The Node Name Selection window is displayed.

	If no changes are required, click Continue.
	10. The Modify CONFIG.SYS file window is displayed.

	If no changes are required, click No Change.
	11. The Installation Complete window in displayed.

	Click OK to reboot and restart your system.
	12. Start the Live50/Live100 application, and select Tools > Preferences.
	13. The Preferences window is displayed.

	Select Network from the Category scroll bar, and select V.35/RS- 449, in the Network field.
	When you have made the appropriate selections on the Preferences window, click OK.
	14. To verify the integrity of your installation, choose Tools > Diagnostics > Loopback.
	15. From the Diagnostics window, choose View > Current Call Information.

	On the Current Call Information screen, verify that:
	16. When you have verified the integrity of your installation, click End Test to finish the Loopb...


	IMUX Cabling Configurations
	Note: A better cable solution for the above system is shown in Figure 6.

	Cable Pinouts

	PINOUTS FOR Live50/100 RS-449/RS-366 4-Leg DDM CABLE (#180-0312-01)
	1 41
	FGND SGND
	1 19*
	FGND SGND
	21 61
	FGND SGND
	1 19*
	FGND SGND
	2 42
	SD(a) SD(b)
	4 22
	SD(a) SD(b)
	22 62
	SD(a) SD(b)
	4 22
	SD(a) SD(b)
	3 43
	ST(a) ST(b)
	5 23
	ST(a) ST(b)
	23 63
	ST(a) ST(b)
	5 23
	ST(a) ST(b)
	4 44
	RD(a) RD(b)
	6 24
	RD(a) RD(b)
	24 64
	RD(a) RD(b)
	6 24
	RD(a) RD(b)
	5 45
	RT(a) RT(b)
	8 26
	RT(a) RT(b)
	25 65
	RT(a) RT(b)
	8 26
	RT(a) RT(b)
	6 46
	TT(a) TT(b)
	17 35
	TT(a) TT(b)
	26 66
	TT(a) TT(b)
	17 35
	TT(a) TT(b)
	7 47
	RS(a) RS(b)
	7* 25*
	RS(a) RS(b)
	27 67
	RS(a) RS(b)
	7* 25*
	RS(a) RS(b)
	8 48
	CTS(a) CTS(b)
	9 27
	CS(a) CS(b)
	28 68
	CTS(a) CTS(b)
	9 27
	CS(a) CS(b)
	9 49
	DTR(a) DTR(b)
	12 30
	TR(a) TR(b)
	29 69
	DTR(a) DTR(b)
	12 30
	TR(a) TR(b)
	10 50
	RR(a) RR(b)
	13 31
	RR(a) RR(b)
	30 70
	RR(a) RR(b)
	13 31
	RR(a) RR(b)
	11 51
	DSR(a) DSR(b)
	11 29
	DM(a) DM(b)
	31 71
	DSR(a) DSR(b)
	11 29
	DM(a) DM(b)
	12 53
	RI RC
	15 20
	IC RC
	32 73
	RI RC
	15 20
	IC RC
	21*
	LOS(b)
	21*
	LOS(b)
	3*
	LOS(a)
	3*
	LOS(a)
	37*
	SC
	37*
	SC
	* Tie pins 25 and 21 together. Tie pins 7 and 3 together. Tie pins 19 and 37 together.

	54 13
	SGND FGND
	7 1
	SGND FGND
	74 33
	SGND FGND
	7 1
	SGND FGND
	14 15
	NB1 NB2
	14 15
	NB1 NB2
	34 35
	NB1 NB2
	14 15
	NB1 NB2
	16 17
	NB4 NB8
	16 17
	NB4 NB8
	36 37
	NB4 NB8
	16 17
	NB4 NB8
	55 56
	DPR ACR
	2 3
	DPR ACR
	75 76
	DPR ACR
	2 3
	DPR ACR
	57 58
	CRQ PND
	4 5
	CRQ PND
	77 78
	CRQ PND
	4 5
	CRQ PND
	18 19
	RC SC
	18 19
	RC SC
	38 39
	RC SC
	18 19
	RC SC
	59 60
	PWI DSC
	6 13
	PWI DSC
	79 80
	PWI DSC
	6 13
	PWI DSC
	20
	DLO
	22
	DLO
	40
	DLO
	22
	DLO

	PINOUTS FOR Live50/100 V.35/RS-366 4-Leg DDM CABLE (#180-0313-01)
	1 41
	FGND SGND
	A B
	FGND SGND
	21 61
	FGND SGND
	A B
	FGND SGND
	2 42
	SD(a) SD(b)
	P S
	SD(a) SD(b)
	22 62
	SD(a) SD(b)
	P S
	SD(a) SD(b)
	3 43
	ST(a) ST(b)
	Y AA
	SCT(a) SCT(b)
	23 63
	ST(a) ST(b)
	Y AA
	SCT(a) SCT(b)
	4 44
	RD(a) RD(b)
	R T
	RD(a) RD(b)
	24 64
	RD(a) RD(b)
	R T
	RD(a) RD(b)
	5 45
	RT(a) RT(b)
	V X
	SCR(a) SCR(b)
	25 65
	RT(a) RT(b)
	V X
	SCR(a) SCR(b)
	6 46
	TT(a) TT(b)
	U W
	SCTE(a) SCTE(b)
	26 66
	TT(a) TT(b)
	U W
	SCTE(a) SCTE(b)
	7
	RS
	C
	RTS
	27
	RS
	C
	RTS
	8 48
	CTS CTS
	D B
	CTS SGND
	28 68
	CTS CTS
	D B
	CTS SGND
	9
	DTR
	H
	DTR
	29
	DTR
	H
	DTR
	10 50
	RR RR
	F B
	RLSD SGND
	30 70
	RR RR
	F B
	RLSD SGND
	11 51
	DSR DSR
	E B
	DSR SGND
	31 71
	DSR DSR
	E B
	DSR SGND
	12 53
	RI RC
	J B
	RI SGND
	32 73
	RI RC
	J B
	RI SGND
	54 13
	SGND FGND
	7 1
	SGND FGND
	74 33
	SGND FGND
	7 1
	SGND FGND
	14 15
	NB1 NB2
	14 15
	NB1 NB2
	34 35
	NB1 NB2
	14 15
	NB1 NB2
	16 17
	NB4 NB8
	16 17
	NB4 NB8
	36 37
	NB4 NB8
	16 17
	NB4 NB8
	55 56
	DPR ACR
	2 3
	DPR ACR
	75 76
	DPR ACR
	2 3
	DPR ACR
	57 58
	CRQ PND
	4 5
	CRQ PND
	77 78
	CRQ PND
	4 5
	CRQ PND
	18 19
	RC SC
	18 19
	RC SC
	38 39
	RC SC
	18 19
	RC SC
	59 60
	PWI DSC
	6 13
	PWI DSC
	79 80
	PWI DSC
	6 13
	PWI DSC
	20
	DLO
	22
	DLO
	40
	DLO
	22
	DLO
	Maximum Cable Length

	RS-449 Cable Lengths
	56 or 64
	4000 feet (1200 meters)
	384
	1476 feet (450 meters)
	768*
	575 feet (175 meters)
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	Installing the 384 Kbps Option
	1. From either the Windows 3.1x Program Manager or the Windows 95 Start Menu, select the Run ... ...
	2. Insert the 384 disk and enter a:\setup in the Run dialog box.
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	How to Order ISDN in the United States
	What to Ask
	What You Need to Provide


	AT&T 5ESS Switch Information
	Northern Telecom DMS-100 Switch Line Information
	Siemens EWSD NI-1 Switch Settings
	ISDN Ordering Phone Number Listing
	NT1 Sources


	appf.pdf
	E
	Deinstalling PictureTel Live
	Deinstalling PictureTel Live Version 1.6 (or 1.5) and LiveShare Plus Software
	1. Preserve any phone books you want to save.
	2. Remove the PCS-related memory exclusion, if any, from the CONFIG.SYS file.
	3. To remove the PictureTel LiveShare Plus software, select Run from the Windows Program Manager ...
	4. Delete these files:
	5. Remove the PictureTel Live changes from the SYSTEM.INI file.

	a. In the [BOOT] section, change the line
	b. In the [386ENH] section, remove the line
	c. In the [386ENH] section, remove the EMM EXCLUDE statement that corresponds to the PictureTel L...
	d. Entirely remove the section
	6. Delete the directory where the software was installed, typically:
	7. Run Windows Setup, and select a non-PictureTel VGA driver.
	8. In Program Manager, delete the PictureTel Live PCS icon group.

	1. Turn your PC off.
	2. Turn your PC on again.

	1. Turn off your PC.
	2. Remove the PCS 50 or 100 hardware.
	3. Enable or restore your original VGA hardware.



	Deinstalling PictureTel Live Versions Earlier than 1.5
	1. To remove the earlier version of PictureTel Live Share software, select Run from the Windows P...
	2. Preserve any PictureTel Live phone books that you want to save.
	3. Remove the PCS -related memory exclusion from the CONFIG.SYS file.
	4. Remove the PictureTel Live changes from the WIN.INI file.
	5. Remove the PictureTel Live changes from the SYSTEM.INI file.

	a. In the [BOOT] section, change the line:
	b. In the [BOOT] section, restore the line:
	c. In the [BOOT] section, restore the line
	d. In the [386ENH] section, remove the line:
	e. In the [386] section, remove the EMM.EXCLUDE statement that corresponds to the PictureTel Live...
	f. Write down the system settings in the [PICTEL00] section, so that you can use the same setting...
	g. Entirely remove the section:
	h. Entirely remove the section:
	6. Delete these files:
	7. Delete the directory where the software was installed, typically:
	8. In Program Manager, delete the PictureTel Live PCS 100 icon group.
	9. Turn your PC off.
	10. Turn your PC on again.
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	Changing the Video Mode Setting
	1. Exit Windows.
	2. Edit your AUTOEXEC.BAT file by adding the following line:
	3. Reboot your system.
	Table F 1: Video Mode Settings
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	Installation Requirements Outside of the United States
	Overview


	This appendix contains the following information:
	The following sections describe the BABT and AUSTEL requirements that must be met for the approva...
	Installation Information

	The following statement describes the installation requirements for BABT approval in the United K...
	The following statements describe the installation requirements for AUSTEL approval:
	Safety Information

	The following statements describe the safety requirements for BABT and AUSTEL approval.
	The Live50 and Live100 boards are designed for use with an IBM compatible PC. The network interfa...
	The Live50 board has the following ports for connection to the network and other apparatus:
	Table G 1: Live50 Board Port Connections 

	The Live100 board has the following ports for connection to the network and other apparatus:
	Table G 2: Live100 Board Port Connections 
	Power Requirements

	The following statements describe the power requirements for BABT and AUSTEL approval.
	The Live50 and Live100 boards are powered from the host chassis and have the following power requ...
	Table G 3: Power Requirements

	The power drawn from the host chassis together with that required for any other expansion boards ...
	The Live50 and Live100 boards must be installed in such a way that the integrity of the network p...
	The clearance and creepage distances shown as X and Y in Figure G 1 and as listed in Table G 4 mu...
	The exception to this requirement is the edge connector, which is located in the host chassis pow...
	Table G 4: Clearance and Creepage

	The creepage distances shown apply in a normal office environment. Where the local environment wi...
	The user should obtain advice from a competent telecommunications safety engineer if in doubt.
	Figure G 1: PictureTel Live50 and Live100 Boards Clearance and Creepage
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	Performance Tips
	Overview
	Configuration Tips
	Memory Tips
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	Laptop Docking Station Configuration
	Overview
	Choosing a Docked or Mobile Configuration
	1. Copy SYSTEM.INI to SYSTEM.DOC.
	2. Run the Windows setup program and change your video driver to VGA.
	3. Try undocking the laptop and running Windows. If everything works properly, copy SYSTEM.INI to...
	4. Create an AUTOEXEC.BAT file that will prompt you for either the docked or mobile configuration...
	5. Add an appropriate section to your CONFIG.SYS file to go along with the AUTOEXEC.BAT file, suc...
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	J
	Ordering and Returning Components
	Ordering Components
	1. Locate the appropriate part number using the tables in this appendix.
	2. Call PictureTel Customer Services at 800-874-2835 or 508-292-5999, or call your local PictureT...


	Live 50 Part Numbers


	The following table lists part numbers for the PictureTel Live 50 product components.
	Live 100 Part Numbers

	The following table lists part numbers for the PictureTel Live 100 product components.
	Returning Components
	1. Request a return material authorization (RMA) number.
	2. Wrap the component in an antistatic bag, if necessary.
	3. Pack the component in a shipping container, using bubble wrap as needed.
	4. Mark the outside of the shipping container with the RMA number.
	5. Send the container to your local PictureTel distributor or to this address:
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